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Introduction 
Starlog Version 4.0 (Starlog V4) is a software package designed for the management of Unidata loggers.   It 
is a standalone software application designed to replace existing Starlog or Starflow software, and provide 
the advantages of a 100% Windows interface. 
 
Features: 
• Powerful scheme creation system. 
• Comprehensive instrument library and editor. 
• Multiple user profiles (basic, technical, system developer). 
• Multi-buffer support. 
• Telemetry support. 
• Backward compatibility with Starlog version 3 schemes. 
• Fully Windows XP compliant. 
• Unloads data and converts automatically to a CSV (Comma Separated Value) file for easy data 

manipulation and viewing in Excel, Hydstra, or Magpie. 
• View unloaded data in a graphical and textual format with the internal data viewer. 
• View real-time readings from the logger in a graphical or textual format. 
• Connect to remote sites via a standard phone or cellular modem. 
• Manage multiple sites from a single PC. 
• Configure basic parameters of the logger scheme. 
 
Note that at present Starlog V4 is unable to: 
• Receive alarms from loggers. 
• Program/unload to/from PCMCIA memory cards. 

System Requirements 
• Pentium Processor 233MHz 
• 64MB RAM 
• 32MB hard drive space 
• Windows XP or 2000 
• SVGA monitor 
• Mouse 
• RS232 serial port 

What Is Data Logging? 
Data logging is the process of collecting and retrieving data.   It is not new.   Humans have collected data for 
millennia, for example, the ancient Egyptians recorded astronomical data using the instruments of their day.   
Such data collection was labour intensive and became difficult if an experiment lasted over a long period or 
required very high sampling rates. 
 
Automated data logging is a product of the Industrial Age.   The first type of automated equipment was the 
chart recorder.   An instrument was connected to a pen that continuously left marks on a piece of paper, 
eventually resulting in a graph over time.   The advent of microprocessors in the early 1970’s enabled fully 
automated data logging.   It also meant that it became possible to keep collected data in a form suitable for 
further processing.   At this time the Data Logger was born.   A Data Logger is a battery-powered computer 
with specialized input/output, power and memory systems. 
 
In the late 1980’s, there was a move toward telemetric data logging where data was collected via a dial-up 
satellite or PSTN link however regulations and cost prohibited wide spread use.   In the 1990s cheap cellular 
phones and modems, and the introduction of GSM and CDMA, made widespread telemetric logging possible 
however the problems of scaling such systems into large automated data collection networks became 
apparent. 
 
Most recently, the Internet, combined with GPRS, Ethernet, wireless and fibre has become a form of 
networked data logging system.   GPRS and Ethernet are the focus of a number of development projects at 
Unidata. 
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The Starlog Data Logging Advantage 
Starlog was specifically designed to log data in remote locations.   Remote locations can be geographically 
remote or just an inconvenient distance from common amenities and services. 
 
Starlog’s advantages in geographically remote locations can be seen when considering a task like monitoring 
weather conditions in some remote location in Siberia.   You could install a Starlog Data Logger in a 
weatherproof enclosure and connect temperature, humidity, and wind speed and direction sensors.   Once 
installed you can retrieve acquired data using satellite, CDMA or GSM telemetry, making the need for site 
visits exceedingly rare. 
 
The high cost of making services such as electricity and telephone lines available can have the affect of 
making the conditions at a nearby location effectively the same as those in a remote location.   Since the 
data logger has its own power supply, Starlog is ideal in these circumstances. 
 
Data logging is a valuable tool for researchers, resource managers and industry. 
 
Applications include: 
• Water Resource management; 
• Environmental Protection; 
• Agricultural Studies; 
• Alternative energy research; 
• Salinity Control; 
• Drainage and Storm Water Monitoring; 
• Forestry Management; 
• Ground Water Research; 
• Resource Development; and 
• Meteorology. 
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What Is This Software Package For? 
Unidata loggers can be described as small computers with specialized I/O (Inputs and Outputs).   Just as 
your desktop PC is not much use without an Operating System, or applications (Microsoft Office or Adobe 
Acrobat) a Unidata data logger is not much use without a running program or project.   We refer to this 
program as a scheme. 
 
When you have selected the hardware for the data logging system, five steps are required by the user for its 
operation. 
 

 
 

What Is A Scheme? 
Using Starlog data logging systems, a data logging project is called a scheme.   Elements of a scheme are 
grouped into the following categories: 
• General Details 
o Scheme title used for reports, printouts. 

• Hardware Details 
o The Unidata data logger being used. 
o What extensions to the logger (if any) are used, for example, relay modules, input modules, output 

modules, etc. 
• Communications Settings 
o Logger to computer communications port and speed. 
o Modem setup strings and phone number. 

• Program Details 
o Program type (event-triggered?). 
o How to store data (linear or circular buffer). 
o Scan rate. 
o When to log. 

• Log Buffer details 
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o Average, minimum, maximum, total or raw data. 
o The channels to log. 

• Instruments  
o Instruments connected, channels used, input scaling. 

• Events 
o Definition of events to trigger an output pulse or to log. 

 
A scheme combines these elements to generate a working program to operate the logger.   The program 
instructs the logger, for instance, to “log the average hourly temperature measured by a thermistor probe 
connected to analogue channel 1. 

Starlog V4 Package Overview 
Starlog software is specially designed to manage a data logging scheme and data unloads. 
 
It is intended to be installed onto a computer where you may use it to create new schemes, load, unload and 
process data and test logger operation. 
 
The software has a Windows style, complete with drop down and pop menus and help messages, as well as 
easy access to Unidata’s extensive support documentation. 
 
The easy-to-use menus are especially helpful in setting up your data logging project.   You use the Scheme 
Editor to define what kind of data to collect and how and when it will be logged.   Then, using the Navigator 
Control bar, you can load the scheme into the logger. 
 
Once data has been acquired by and stored in the logger, you can use the Starlog software to unload it 
again using the Navigator Control bar.   Logged data is transferred to your computer in Comma Separated 
Value (CSV) file format.   This format allows easy importing of your data into 3rd Party data management 
and manipulation software such as Hydstra, Tideda and Magpie. 
 
To check logger operation, the software includes a test mode.   In test mode the logger displays data as it is 
acquired.   It also displays the logger status and other important information. 
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Installation 

Upgrading From Version 3 Software 
Version 4 software cannot automatically convert your version 3 schemes to version 4.   If you want to convert 
your old schemes you will have to do it yourself.   If you don’t want to convert your old schemes, version 4 
software can still use them.   Version 3 schemes can be programmed and unloaded.   They can also be 
edited, but that requires a copy of Version 3 software to be installed, as version 4 software cannot edit the 
scheme, but requires the version 3 scheme editor for that.. 
 
If you are installing your new version 4 software on a different computer from your existing version 3 
software, it is recommended you move your version 3 software to your new computer before installing your 
new version 4 software. 
 
This is because the version 4 software can automatically configure itself to access your existing schemes, 
but only if they are on the same computer. 
 
Version 3 software is typically installed in the C:\STARLOG or C:\STARFLOW folders.   Just copy the folder 
as-is to the new computer, making sure the folder names stay the same, i.e. copy if it was installed in 
C:\STARLOG on the old computer, copy it to C:\STARLOG on your new computer. 
 
If you cannot (or don’t want to) move your version 3 software before installing the version 4 software, you 
can still proceed with the installation, but you may need to manually configure the version 4 software as 
described under Starlog V3 Options on page 14. 

Starting from CD-ROM 
Insert the CD-ROM disc into the drive.   It should start automatically.   If it doesn’t go to Start → 
Programs/All Programs → Accessories → Windows Explorer.   Select your CD-ROM drive and 
double-click on Launcher. 

Starting from Downloaded Files 
There is a 30-day trial version of Starlog V4 available from our web site. 
 
1. To download the required files, go to the Unidata web site: 
http://www.unidata.com.au/products/software/6292/ 

 

 
 
2. Click on Starlog V4 Software to download starlog_v4.zip. 
3. Unzip that file into a temporary folder. 
4. Open the folder and run the Setup file. 

http://www.unidata.com.au/products/software/6292/
http://www.unidata.com.au/products/software/6292/


Starlog V4 Software – Model 6308  Unidata Pty Ltd 

Unidata Manual - 6308 Starlog V4 6 SW Manual Issue 2.7  

Installing the Software 
Having started the installation procedure, you should be seeing the following screen: 
 

 
 
Follow the prompts to install the software.   If you are asked to restart your computer, you should do so. 

Using the Software for the First Time 

Launching the Software 
To start Starlog version 4, you can double-click on the icon on your desktop: 
 

 
 
Alternatively, you could select the program from the start menu: 
 
 

 
 

Support Files 
The first time Starlog version 4 is run, it needs to install some extra support files and configure itself: 



Unidata Pty Ltd  Starlog V4 Software – Model 6308 

 

 
 
Click Extract to install the support files. 

Backward Compatibility 
The next dialog lets you configure the Compatibility support for Starlog/Starflow version 3 software: 
 

 
 
The above shows a typical configuration.   You may need to change the values to suit the configuration of 
your Starlog/Starflow version 3 installation.   If you don’t have Starlog version 3 installed, just click Next to 
continue. 
 
If you want to change these later, you can edit them by going to File → Options → Configure 
StarlogV4 → Starlog V3.   See Starlog V3 Options on page 14. 

Registration 
The next dialog requires you to enter your User Name and Code Key to register the software.   If you don’t 
enter a valid User Name and Code Key then you have 30 days as a trial user before you are unable to use 
Starlog version 4.   You will have the opportunity to enter a valid User Name and Code Key every time you 
restart Starlog version 4. 
 
There is and option to register All Instruments & Loggers in Starlog 4 or the Starflow Instrument Only. Do this 
accordingly based on your requirements. 
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Assuming what you’ve entered is correct and what option you have enabled, you’ll see the following: 
 

 
 
If you instead see the message Incorrect key or invalid user name entered, click OK then 
double-check the values you’ve entered.   If you continue to have problems, contact your software vendor. 
 
The next screen confirms your User Name and Code Key.   Click Finish to complete the setup and enter 
the main software screen. 

Options 
Once the software is running, it is recommended to check some settings to make sure they are correctly set 
before doing significant work with Starlog V4.   See Options on page 11. 
 

Un-installation 
 
If you decided to uninstall StarlogV4 you can do so via the Windows Uninstall or change program feature.  
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Proceed with the Remove option and you will be asked if prompted with the dialog: 

 

 
 
 
Warning! If you select Yes all scheme files will be purged from the system along with the whole StarlogV4 
directory and it will not be recoverable. If no is selected these things will be preserved. 
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General Information 

Starting the Software 
To start Starlog version 4, you can double-click on the icon on your desktop: 
 

 
 
Alternatively, you could select the program from the start menu: 
 
 

 
 
 
Starlog version 4 has the following program structure: 
 

 
 
The most common logger operations are simple to start from the main Starlog window.   The main Starlog 
version 4 window and major functional areas are shown below: 
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Scheme Control Icons 

Scheme Name 
Area 

Communications 
Diagnostics 

Tools 
Launch Bar 

Communications 
Status Area Communications 

Settings  
 
• Quickstart Bar: This is the toolbar of icons down the left side.   It can be toggled off/on by selecting 
Show Quickstart Bar from the Window menu. 
o Scheme Control Icons: These provide access to scheme-related functionality, such as selecting a 

scheme, editing a scheme, and viewing data logged by the scheme.   If you can’t see them, click on the 
Starlog V4 button to show them. 

o Communications Diagnostics Tools: These provide access to tools useful for troubleshooting 
communications problems.   Click on the Diagnostics button to show them. 

o Launch Bar: This is where you can add groups of external applications.   Such applications might 
include custom data analysis tools you may have.   When you add your first external application, the 
“Launch” button will be replaced with a button labelled with the name of your nominated group.   As you 
add applications with different group names, buttons for each group will be added to the bottom of the 
bar.   See also Launch Programs Toolbar on page 18. 

• Communications Status Area: This will read Connected when you are connected to a logger, and 
Disconnected (or blank) when you are not connected to a logger. 

• Scheme Name Area: This shows the name of the currently selected scheme. 
• Communications Settings: When connected to a logger, this shows the used communication settings.   

For example: COM1:9600,N,8,1, which indicates that COM1 is the port used, the baud rate is 9600, N 
means no parity, 8 is the number of data bits, and 1 is the number of stop bits. 

Options 
Go to the File menu and select Options, then Configure StarlogV4. 

General Options 
The Schemes Path is where your scheme program files will be saved.   These are the scheme program 
definition files and not your logged data. 
 
Preferred Units is where you select your preferred general type of engineering units. 
 
Tick Load last used scheme on Startup if you want the same scheme you were working with when 
you last exited Starlog to be automatically loaded when you next run Starlog.   If this setting is not ticked and 
Enable Embedded Schemes (see below) is, Starlog will default to the Embedded Scheme (see the 
embedded scheme instrument on page 78), that is, it will attempt to use a scheme that has been embedded 
within the data logger.   If there is no embedded scheme or embedded support has been disabled, Starlog 
will read the scheme name from the logger and attempt to load the scheme with that name. 
 
The Enable Embedded Schemes checkbox controls if Starlog will attempt to use any embedded scheme 
data.   If support is disabled, Starlog will not even look for embedded data.   Any embedded data that may 
exist will be ignored. 
 
Generate Neon Upload File controls if Starlog will create a .neon file ready for uploading to the Neon 
system.   A .neon file is actually a Zip archive that contains a selection of scheme files so that they can be 
uploaded in one action. 
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The Auto-resize Test Mode log buffer columns checkbox toggles the automatic resizing of the 
columns of logged data in the test display.   Normally, the columns are re-sized every time the display 
updates (i.e. every scan) which results in considerable flicker.   Turning this option off will greatly reduce 
flicker, but may result in columns sometimes not being wide enough to fit the data which will require manual 
adjustment.   Changes to this option will not affect already opened Test Mode windows; only subsequently 
opened windows will be affected. 
 

 

Data Options 
The V4 Root Data Path  setting is already set to a suitable default and should not be adjusted. However, 
if you need to save your unloaded scheme data to a different location, you can set that location here. The V4 
Data Path Options are a set of checkboxes that customise the generated data folder names. Changing 
then will update the example scheme name so can immediately see what effect each checkbox has. 
 
The Backup Data Path is used by the Unloader function (see Unloading Data from Loggers on page 39) 
to store duplicate copies of any unloaded data. 
 
Output File Headers controls what information is included in the headers for each column of data 
recorded by your log programs. 
 

 



Unidata Pty Ltd  Starlog V4 Software – Model 6308 

 
If Unload Comment is ticked, then each time you unload a logger, you will be asked to enter a comment.   
See Unloading Data from Loggers on page 39. 
 
In the following sample file: 
 
test -  
S/N: 7434 
SITEID:ABC123 
COMMENT:Test comment 
Time, Voltage(RAW), Voltage(RAW), Temperature(RAW), Humidity(RAW) 
 , mV, mV, degC, pct 
04/10/2006 15:59:50, 1051.0, 896.0, 26.4, 96.1 

 
test is the scheme name, S/N: 7434 is the logger serial number, SITEID:ABC123 is the site ID, 
COMMENT:Test comment is the comment that was entered at the time the data was unloaded, Time, 
Voltage(RAW), Temperature(RAW), and Humidity(RAW) are the Channel Labels (which also 
incorporates the type of logging, see Instrument Channels on page 27 for a list of types), and mV, degC, and 
pct are the Channel Units. 
 
The remaining lines are the logged data. 
 
The Data file naming convention field allows you to control how Starlog V4 names your unload files.   
Unload file names must always end with a “.CSV” extension, but the entire preceding portion of the filename 
can be customised. 
 
The default naming convention is “[SCHEME]_[INDEX]”, where [SCHEME] and [INDEX] are variables.   
Variables are replaced with their value when the unload file is created.   Click on Insert Variable to see 
a list of the available variables: 
 

 
 

Variable Description 
[SCHEME] The name of the scheme. 

[SERIALNUMBER] The serial number of the logger. 

[DATE:format] 

The date when the unload took place, in the specified format.  
yyyy is replaced with the year (eg 2007), mm is replaced with 
the month (eg 02), and dd is replaced with the day of month 
(eg 01).   Inserting the variable [DATE:yyyymmdd] would be 
replaced with something like 20070201. 

[INDEX] A number one greater than the current largest unload index 
number. 

[BUFF] The number of the buffer being unloaded. 
[SITEID] The ID of the site.   See the SITEID instrument on page 81. 

 
The date format may be edited after it has been inserted into the naming convention field.   Supported data 
formatting codes include: 
 

Format Description 

c Combined date and time, separated by a space.   The date is formatted as per 
the Short Date format in the Windows Control Panel Regional Settings.   The 
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time is formatted as specified in the Windows Control Panel Regional Settings. 
d One to two digit day of month (1-31). 
dd Two digit day of month (01-31). 
ddd Short day of week (Sun, Mon, …, Sat). 

dddd Long day of week (Sunday, Monday, …, Saturday). 

ddddd Date formatted as per the Short Date format in the Windows Control Panel 
Regional Settings. 

dddddd Date formatted as per the Long Date format in the Windows Control Panel 
Regional Settings. 

h One or two digit hour (0-23). 
hh Two digit hour (00-23). 

m One or two digit month (1-12) or minute (0-59).   Which value is used is 
determined by the context of nearby formats. 

mm Two digit month (01-12) or minute (00-59).   Which value is used is determined 
by the context of nearby formats. 

mmm Short month name (Jan, Feb, …, Dec). 
mmmm Long month name (January, February, …, December). 

n One or two digit minute (0-59). 
nn Two digit minute (00-59). 
q Single digit quarter of the year (Jan-Mar=1, Apr-Jun=2, Jul-Sep=3, Oct-Dec=4). 
s One or two digit second (0-59). 
ss Two digit second (00-59). 
w Single digit day of week (Sunday=1, …, Saturday=7). 

ww Two digit week of year (01-53). 
y Day of the year, one to three digits (1-366). 
yy Two digit year (00-99). 

yyyy Four digit year. 
 

Starlog V3 Options 
On the Starlog V3 tab you can set the Starlog version 3 folder locations. 
 

 
 
The StarlogV3 Schemes Path is the location of your version 3 scheme programs.   The Starlog V3 
Data Path is the location of the data files generated by Starlog version 4 when it unloads loggers 
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programmed using version 3 schemes.   The StarlogV3 Application Path is the location of the main 
version 3 executable.   This is used to locate the remaining components of the version 3 software. 
 
The Generate StarlogV3 support files checkbox determines if Starlog version 4 will generate 
various files used by version 3 software, but no longer required in version 4.   Such files include the SCM 
(version 3 scheme definition), INI (text file of scheme settings), FTU (test display) and ENT (log buffer 
display).   This is to support non-Starlog software packages that look for and use those files. 

Communications Mapping 
The Communications Map is where you create and name your required communications interfaces.   For 
example, you might have one communication interface for when you connect directly via a serial cable to a 
local data logger, and a second communication interface (possibly on the same physical serial port as your 
cable) for when you use a modem to connect to a remote data logger. 
 
You will need to ensure your Communications Maps are correctly configured before you attempt to program 
or unload a data logger. 
 
The Communications Map is accessed from the main Starlog V4 window via the menus File → Options 
→ Communications Map. 
 

 
 
By default all your physical serial ports will be listed, plus a Network port.   The default serial ports are all 
“direct”.   To support modem communication, click the New button and select Phone modem (RS232) from 
the list: 
 

 
 
Click OK.   A new communication map for a modem will be added to your list: 
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You will now need to configure it to use the correct serial port (RS232 Communications Port), preferred baud 
rate, and any special dialling prefix numbers to get an outside line if you’re on a PABX. 
 
Note that you do not configure any telephone numbers in this dialog.   You will select the required 
Communications Device and set the telephone number when creating/editing a scheme via the Settings 
dialog in the Scheme Editor.   See Creating / Editing a Scheme on page 21. 

User Profiles 
User profiles are used to simplify the operation of Starlog V4 by limiting the number of visible options.   If you 
are the only person using the software, you may wish to ensure the full functionality of the software is 
available. 
 
User Profiles can be adjusted from both the main Starlog window (File → Options→ Set Access) and 
the Scheme Editor (File → Setup → Set Access). 
 
However you get to it, the following dialog will appear: 
 

 
 
Starlog version 4 starts in the DEFAULT profile, which only allows access to a subset of Scheme Editor 
functionality.   The ADMINISTRATOR profile has complete access to all aspects of the Scheme Editor and the 
various libraries, including data logger definitions and the raw code generated by the Scheme Editor.   The 
LOCKDOWN profile is more restrictive than the DEFAULT profile, allowing only simple scheme changes. 
 
Select which profile to use via the Set Current Profile drop-down list box. 
 
If none of the built-in options match your preferences you can create your own named profiles with the exact 
settings required.   Click Add Profile, and then enter the name of your new profile.  A new default profile 
will be added to the list.   Select it, and then adjust the available features as required. 
 
To remove a profile you don’t want, select it, and then click Delete Profile. 
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Once you have made your selection, it is possible to lock the configuration so it cannot be changed.   This is 
useful for when you are setting up a “turnkey” type system where unrestricted use of the Scheme Editor may 
be inappropriate. 
 
To lock the User Profile, click the Lock button. 
 

 
 
You will need to enter your password twice to make sure you’ve got it right.   The Lock button will change to 
Unlock.   If you need to change the User Profile settings in the future, click the Unlock button, enter your 
password, and make your changes. 
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Launch Programs Toolbar 
The Launch Programs Toolbar allows you to setup icons to run external applications.   Icons are put into 
named groups. 
 
Click on the Launch button at the bottom of the main tool bar.   If you’ve added any applications you will see 
one or more buttons with your nominated group names.   Click on one of those instead. 
 
Click on the New Shortcut icon.   A small window will 
appear that lists all the applications you have added.  It 
will be empty if you haven’t added any. 
 
There are three buttons down the right side of the 
window.   If there are no applications in the list, the 
bottom two (Edit Program and Delete Program) 
will be greyed out. 
 

 
 
Click on Add Program.   Fill in the fields as required, and then click OK.   An example is shown below: 
 
 

 
 
The Program Group specifies the toolbar group into which the shortcut will be placed.   The Program 
Name is the title that will appear under the program icon in the toolbar.   The Protected checkbox in 
combination with the User Profile option “Enable protected shortcut buttons” (see User Profiles on page 16) 
controls whether or not the shortcut will be visible. 
 
The Program Path is the full pathname of the application executable file.   The Command Line field 
supports special Keyword/Placeholder variables.   Click Insert Keyword to select the 
keyword/placeholder you want from a list: 
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Double-click on the item to insert it into the Command Line field. 
 
Once an application has been added, the Edit Program and Delete Program buttons become active.   
Clicking Edit Program takes you to a dialog the same as for Add Program.   Clicking Delete Program 
will immediately delete the selected application. 
 

 

Arranging Windows 
All open windows within the Starlog application may be arranged by selecting the Tile or Cascade options 
from the Window menu. 

Finding the Version of the Software 
To find out what version of Starlog version 4 you have, select About StarlogV4 from the Window menu.   
A window similar to the following will appear: 
 

 
 
The version number is shown at the top right (“04.00.0079”).   When requesting technical support in relation 
to the software or your schemes, always mention the version of your software. 
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Manually Connecting to a Logger 
Although you would typically configure the logger communications in the scheme (see Settings on page 23), 
it is also possible to manually connect to a logger. 
 
On the main StarlogV4 window, click either the Connection icon in the StarlogV4 group 
(as shown to the right), or select Connection from the Logger menu. 
 
The following window will appear: 
 

 
 
Select the COM port to connect to using the drop-down list.   Click Connect to connect to that port.   You 
may then process to program, unload, or test the logger. 
 
When connected, the Connect button will change into a Disconnect button.   Click that button to 
disconnect from the logger. 
 
There is also a More>> button.   Click that to display statistics related to the connection (as shown above).   
When clicked, it will change into a >>Less button.   Click that to hide the statistics. 
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Scheme Management 

Selecting a Scheme 
To select a scheme, click on Select Scheme from the File menu, or click the Select icon 
(shown to the right).   The following window will appear: 
 

 
 
The tabs at the top allow you to view all your version 4 schemes, all your version 3 schemes (if you have 
any), or to select the scheme embedded into logger (the logger must have been programmed with the 
“SCHEME” instrument).   Select a scheme by double-clicking its name. 

Creating / Editing a Scheme 
The Scheme Editor is used to create, edit and delete schemes.   It can also create templates and data 
logging systems.   The program structure is shown below: 
 

 
 
The Scheme section is mainly used for creating and editing schemes with standard functionality. 
 
The Library section is used for modifying the available libraries.   Organisations with standard logging 
systems can create templates to suit those systems.   There is essentially no limit to the systems that can be 
built. 
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The Code section is for those schemes with extended functionality that require custom code.   It contains a 
Code editor with tools that assist layout and increase readability. 
 
 

To create a scheme, you need to open the Scheme Editor.   Click on Scheme Editor 
from the File menu, or click on the Scheme Editor icon in the main window (as shown 
to the left). 
 
 

 
 

NOTE: Version 4 software cannot edit version 3 schemes.   You must keep a copy of 
version 3 software installed if you want to edit your old schemes.   If you select a version 
3 scheme, Starlog V4 will automatically launch the version 3 scheme editor to edit the 
scheme.   You can also manually launch the version 3 scheme editor by clicking 
V3 Scheme Editor from the File menu. 

 
When the Scheme Editor is open, select New Scheme from the File menu, or click the New icon on either 
of the toolbars: 
 

    
 
A list of data loggers will appear.   Select the data logger you will be using by double-clicking it.   For 
example, a “6004-2” is selected below: 
 

 
 
Three new icons will appear inside the left toolbar: Settings, Instruments, and Log Buffer. 
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Settings 
These are settings for controlling basic logger functionality. 
 
Click on the Settings icon: 
 

 
 
One of the most important settings is the Scan Rate.   This defines how often the logger scans (samples) 
its inputs.   Faster scan rates make it more likely the data logger will capture accurate minima and maxima, 
but will shorten the battery life. 
 
The scan rate also influences averaging.   If you want to log average data every 15 minutes, then a 5 second 
scan rate implies 15×60÷5=180 samples.   If you don’t need that many samples, you could increase the scan 
rate to maximize battery life. 
 
Another limit the scan rate imposes is on the maximum logging interval.   The maximum log interval is 65535 
times the scan rate.   For example, if you set the scan rate to 1 second, the maximum logging interval is 
65535 seconds, or 18 hours 12 minutes 15 seconds.   If you want a log interval of 1 day, you would need a 
scan rate of at least 2 seconds. 
 
The Logger Serial Number is optional, and may be left blank. 
 
The Scheme Description should be set to something that will assist you in remember what the scheme is 
for. 
 
Apart from the Scan Rate, the Communication settings are the next most critical.   If they’re wrong, you 
won’t be able to program or unload your logger!   You should have configured your communications settings 
earlier under Communications Mapping on page 15. 
 
The Telemetry Switch field lets you enter the code to select the logger if you have a telemetry switch 
installed.   You must include the “Q” in the field, for example, “Q01”. 
 
The Advanced button allows you to directly edit various communications settings.   Double-click on the 
Value fields to edit them. 
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For detailed information on each of the settings, see Appendix – Communications Variables on page 85. 

Instruments 
The Instruments window lets you define what instruments are connected to the logger.   Instruments define 
the relationship between what the logger measures (voltages, pulses/counts, digital data) and what the 
instrument measures (temperature, depth, wind speed, etc). 
 
Click on the Instruments icon (shown to the right): 
 

 
 
The Instrument Library lets you select from major groups of instruments.   Starlog version 4 Software 
comes with the following predefined groups: 
 
• Loggers – Unidata logger instruments 
• PDLTRANS – Unidata Instrument Library 
• NIWA – NIWA Instrument Library 
 
It is possible for you to create custom instruments and libraries to keep them in. 
 
When you select an Instrument Library, all the instruments in the library relevant to the selected logger are 
shown. 
 
The right half of the Instruments window shows the instruments that have been added to your scheme. 

Adding an Instrument 
To add an instrument to your scheme, either double-click on its line in the left half of the window, or select it 
then click the Add button at the bottom of the window.   A copy of the instrument will be added to the list in 
the right half of the window. 
 
For example, to add the SMS instrument to your scheme: 
 
1. Edit the scheme and select the Instruments icon. 
2. Select the PDLTRANS library. 
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3. Select the SMS instrument in the list. 
4. Click the Add button to add the instrument to the scheme. 
 

 

2

1 

3

4

Removing an Instrument 
To remove an instrument from your scheme, select it from the list in the right half of the instrument window 
and click the Del button at the bottom of the window, or right-click on it and select Delete from the menu. 

Configuring an Instrument 
To configure an instrument, double-click on its line in the right half of the window, or right-click on it and 
select Edit from the menu.   Different instruments have different configuration windows and options. 

Configuring the Logger 
Data loggers are configured just as if they were a regular instrument.   When you create a scheme, an 
instrument for the selected logger is always added as the first instrument.   Double-click on it.   For 
Starloggers, the following window will appear.   Other loggers will be similar: 
 

 
 
The various tabs show the options available.   If you want internal logger channels to be available for logging 
(e.g. the temperature sensor), you will need to make sure their entries on the Internal Channels tab are 
ticked. 

Configuring the Logger as an SDI-12 Sensor 
When the logger is an SDI-12 sensor, other SDI-12 recorders can access and log data sensed by it.   This 
can be useful if you have something with a limited number of inputs, such as a Starflow, but would prefer to 
have all data at a site logged by a single logger.   You could configure the Starflow as an SDI-12 sensor, and 
use a Starlogger as an SDI-12 recorder to log the depth/velocity/flow from the Starflow, as well as whatever 
other instruments you have (eg wind speed/direction, air temperature, rainfall). 
 
To set a logger up as an SDI-12 sensor, first add any required instruments to the logger.   Then open the 
logger instrument (as described under Configuring the Logger above) and select the SDI-12 tab.   Tick 
Enable SDI-12 Sensor Mode to enable the controls.   Next, select the SDI-12 Address to assign to the 
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logger.   Finally, for each channel you want to make available as an SDI-12 reading, click the Add button to 
add it.   The following window will appear allowing you to select from the available channels: 
 

 
 
Double-click on a channel to add it to the list.   Each added channel becomes an SDI-12 value, numbered 
from zero starting at the top.   The following shows “Battery” as parameter 0, and “Internal Temp” as 
parameter 1: 
 

 

Configuring the Logger RS232/UPS 
Open the logger instrument (as described under Configuring the Logger above) and select the RS232 / 
UPS tab. 
 
The RS232 Timeout controls how long the logger will remain powered on and ready to communicate at 
each scan interval.   The factory default for most loggers is 1 second, which is adequate for direct serial 
cable connections.   However, if communications is to take place via a modem, then this should be extended 
to 3-5 seconds (or more, as required).   Longer timeouts will lead to increased power consumption while the 
logger is communicating. 
 
The Scan Synchronous Communications checkbox fine-tunes when the logger checks for a computer 
attempting to communicate with it.   When this checkbox is ticked, the logger will wait until the end of a scan 
before checking to see if there is a computer wanting to communicate with it.   When this checkbox is not 
ticked, the logger does not wait.   After this first check, the logger will only check that the computer is still 
connected at the end of each scan, regardless of the setting of this checkbox.   For quick scan rates, this 
setting does not do much, however, for slower scan rates, clearing this checkbox (to select asynchronous 
communication) may improve the logger’s responsiveness to communications. 
 
The Programmable UPS checkbox controls whether or not the scheme is allowed to program the UPS 
(User Power Supply).   This functionality is currently only available using custom scheme instructions. 
 
The UPS Prescan (ms) setting control how long the UPS is switched on before the usual scan processing 
is started, such the reading of the inputs.   Some instruments powered from the UPS may need more time to 
start than the factory default of 15ms allows.   This setting allows the prescan delay to be extended as 
necessary for those instruments to work correctly. 
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Log Buffer 
Open the Log Buffer window by clicking on the icon shown to the right: 
 
The Log Buffer window is shown below: 
 

 
 
The Log Buffer window is where you set up the logger memory for recording data by selecting what to log 
and how often to log it. 
 
Data loggers have one Main Buffer and multiple Event Buffers.   Event Buffers tend to be small and are used 
to store data logged on an ad-hoc basis.   Whatever memory is not allocated to Event Buffers is allocated to 
the Main Buffer.   Since Event Buffers default to zero bytes, the default Main Buffer size is all the available 
memory.   See also Buffer Sizes on page 28. 

Instrument Channels 
Each Buffer has its own set of the Instrument Channel checkboxes.   You control which of the available 
channels gets logged into each buffer.   The following channel logging options are available; however, some 
instrument channels may not support all of them (for example, temperature cannot be totalised): 
 

Option Description 
RAW The instantaneous value of the channel at the time of the log. 

MIN The minimum of the values sampled at each scan over the 
log interval (see Log Intervals below). 

MAX The maximum of the values sampled at each scan over the 
log interval (see Log Intervals below). 

TOT The total of the values sampled at each scan over the log 
interval (see Log Intervals below). 

AVG The average (arithmetic mean) of the values sampled at each 
scan over the log interval (see Log Intervals below). 

avg The average (arithmetic mean) of the values sampled at each 
scan over the sub interval (see Sub Intervals below). 

 
In the example screenshot shown on page 27, both the Battery and Internal Temperature channels are 
logging the “AVG” (average of the full log interval). 
 
As you tick channels to log, or adjust the Log Interval, the software will automatically update the Memory 
Time to show you an estimate for how long the memory will last.   The estimate does not take into account 
logging forced by events. 

Log Intervals 
The Log Interval is the time between logs.   Only the Main Buffer has a Log Interval setting.   Event 
Buffers do not have a Log Interval because logging into them is always triggered by events. 
 
At each log, all the Instrument Channels ticked will be recorded into the Log Buffer. 
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In the screenshot above, the average internal Battery and Temperature Channels will be logged every 15 
minutes. 
 
The maximum log interval is limited by the scan rate.   The maximum log interval is 65535 times the scan 
rate.   For example, if you set the scan rate to 1 second, the maximum logging interval is 65535 seconds, or 
18 hours 12 minutes 15 seconds.   If you want a log interval of 1 day, you would need a scan rate of at least 
2 seconds. 

Sub Intervals 
The Sub Interval setting only relates to the “avg” column of Instrument Channel checkboxes (not the “AVG” 
column, or any other column).   Rather than take samples at each scan like the “AVG” column, the “avg” 
column only takes samples during the Sub Interval.   The Sub Interval is always the time immediately before 
a Log.   Event Buffers do not support the Log Interval or Sub Interval settings. 
 
For example, if the Log Interval is 60 seconds, and the Sub Interval is 20 seconds, for the first 40 seconds of 
the 60 second log cycle only the “MIN”, “MAX”, and “AVG” channels will take samples.   For the remaining 20 
seconds before the log occurs (the Sub Interval), all channels (including the “avg” channel) will be taking 
samples. 

Buffer Sizes 
Event Buffers must have their size manually allocated.   The Main Buffer size cannot – it is always allocated 
whatever memory is left after memory has been allocated to the Event Buffers.   Click the Set Size button 
to configure the buffers: 
 

 
 
You can adjust the sizes of the Event Buffers in 1KB increments by clicking on the small up/down buttons to 
the right of the Event Buffer Size field.   Increasing the size of an Event Buffer will decrease the size of the 
Main Buffer by a corresponding amount, and vice versa. 
 
Note that the total capacity of all the buffers will always be less than the quoted memory capacity of your 
data logger.   The data logger reserves some memory for the scheme program, working variables, 
communications buffers and configuration data. 

Other Buffer Settings 
Settings common to all buffers are: 
 
• Linear / Circular: When Linear buffers fill up, they stop accepting new logged data.   When Circular 

buffers full up, they wrap around to the beginning and start overwriting the oldest data. 
• Instrument Channel Ordering: This defaults to Auto Order, however, you can untick the checkbox and 

click on the Set Order button to manually set the logging order of the channels: 
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Click on the channel to select it, and then click on the up/down buttons on the left to nudge it up/down the 
list. 

Events 
Events allow the logger to act on changes on its inputs.   Various actions include triggered logging, SMS 
alerts and relay control.   A maximum of 32 events are supported. 

Types of Events 
There are many different types of events: 
 
Event Type Description 
None  
Always An event that is always TRUE. 
Channel A > B 
Channel A >= B 
Channel A < B 
Channel A <= B 
Channel A = B 
Channel A <> B 

Compares channel A with a fixed value B 
 
NOTE: “<>” is “not equal” (≠). 

Channel A > Channel B 
Channel A >= Channel B 
Channel A = Channel B 
Channel A <> Channel B 

Compares a channel A with a second channel B. 
NOTE: There are no “less than” comparisons as “Channel B < Channel 
A” is the same as “Channel A > Channel B”. 

Delta Channel A > B 

Monitors channel A and becomes TRUE for one scan when that channel 
has changed by more than B since the last time the event was triggered.  
If channel A has changed by more than B since the event was last true, 
the extra difference is forgotten for determining when the event will next 
be true.   If the remainder is important, use the “Every B on Channel A” 
event. 

Event A AND Event B Becomes TRUE when both event A and event B are TRUE 
Event A OR Event B Becomes TRUE when either or both of event A or event B are TRUE 

Delta Event A Becomes TRUE for one scan when event A changes state (from FALSE 
to TRUE, or from TRUE to FALSE) 

Every B on Channel A 

Every scan the absolute difference between the current channel A 
reading and that of the previous scan is added to an accumulator.  
When that accumulator exceeds B, the event is true for that scan and B 
is subtracted from the accumulator.   Both rises and falls add to the 
accumulator, so that a rise of 3 units and a fall of 2 would result in an 
accumulation of 5 units. 

NOT Event A Evaluates to the opposite of event A.   If event A is TRUE, this event is 
FALSE, and vice versa. 

On Event A for B Scans This event becomes TRUE when event A becomes TRUE, and is held 
TRUE for B scans. 

On Event A Until Event B This event becomes TRUE when event A becomes TRUE, and stays 
TRUE until event B becomes TRUE. 

Event A TRUE for B Scans This event becomes TRUE for one scan whenever event A has been 
TRUE for B consecutive scans. 
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Event Type Description 

Channel A between B and C This event is TRUE whenever channel A is between the values B and C 
inclusive. 

Channel A bit B set This event is TRUE when bit B of channel A is set. 
Channel A bit B not set This event is TRUE when bit B of channel A is not set. 

Channel A High 
(A > B, Reset A < C) 

This is a channel A high event with hysteresis.   When Channel A rises 
above the value B, the event becomes true.   It will then not become 
false until channel A falls below value C.   C must be less than B. 

Channel A Low 
(A < B, Reset A > C) 

This is a channel A low event with hysteresis.   When Channel A falls 
below the value B, the event becomes true.   It will then not become 
false until channel A rises above value C.   C must be greater than B. 

 

Event Settings 
To edit events, click on the Events icon (as shown to the right).   The default Basic User 
Profile is configured to hide the Events icon.   You will need to enable it by following the 
instructions under User Profiles on page 16.   Make sure the Scheme → Events option is ticked.   
The following window will appear: 
 

 
 
Each event has a name, a description, a type, between zero and three parameters, an output action, and a 
force log action: 
• Name: While there is no particular length limit, this should be a short mnemonic of the event.   It is what is 

shown when another event refers to the event, and in the parameter list boxes for those events that take 
other events as parameters.   You don’t see the description in those list boxes, so make sure the name will 
be enough to remember the purpose of each event. 

• Description: This can be a longer description of the event. 
• Event: This specifies the type of the event.   See the table under Types of Events on page 29. 
• Parameter A: Depending on the type of event this may be a channel or another event. 
• Parameter B: Depending on the type of event this may be a channel, another event, or a constant value. 
• Parameter C: So far, only the “Channel A between B and C” uses this parameter (as a constant value). 
• Output: This is a list of the possible actions the logger can perform for every scan that the event is true. 
• Force Log to Buffer: For every scan the event is true, this will force the selected log buffer to log the 

channels as configured in the Log Buffer window (see Log Buffer on page 27). 
 
The Logwhile Event selects which event is used by the scheme to control when data sampling and 
logging is allowed to occur.   When the Logwhile event is true, the logger will take instrument samples, eg for 
averaging, and will log data as programmed.   When the Logwhile event is false, the logger will still read its 
inputs, but they will not count towards averages, nor will any data be logged. 
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Using Events 
Using events can become complicated because while each event by itself is very simple, to get even 
moderately complex behaviour several events may need to be combined to obtain the required functionality.   
To demonstrate this, the following example describes how to implement hysteresis: 
 
Imagine a logger monitoring temperature and being able to control a cooling system.   When the temperature 
exceeds some threshold, the logger should turn the cooling system on until the temperature is lowered to 
some other threshold whereupon it will turn the cooling system off.   The two thresholds provide the 
hysteresis to prevent the fan from being rapidly turned on and off.   For this example the upper threshold is 
55°C and the lower threshold 50°C. 
 
Start by defining the threshold events: 
 
Name Description Event A B 
HT upper High temp on Channel A > B Internal Temp 55 
HT lower High temp off Channel A < B Internal Temp 50 
 
Next are the two events that reflect whether or not the logger is in the high temperature state: 
 
Name Description Event A B 
HT High temp state On Event A Until Event B HT upper HT lower 
not HT Not high temp Not Event A HT  
 
The “HT” event is true from the time the logger exceeds the “HT upper” threshold (55°C) until the time it falls 
below the “HT lower” threshold (50°C).   In other words, it’s the “temperature is too hot and needs cooling” 
state.   The “not HT” event is true whenever the “HT” is not true, i.e. when the system is not “too hot”. 
 
If all you wanted to do was control a cooling system via relays, the above events are all you need.   You 
would attach a latching relay to the logger (such as the 6525 relay control module), then add a “switch relay 
on” output to the “HT” event and a “switch relay off” output to the “not HT” event.   There’s no harm in the 
logger continuously sending “relay on/off” commands every scan those events are true. 
 
What if you wanted to send an SMS alarm when the system got too hot?   In that case sending multiple 
messages while the system stayed hot wouldn’t be a good idea.   To only send a message when the system 
flips from “temperature OK” to “too hot” requires a few more events: 
 
Name Description Event A B 
HT change High temp state change Delta Event A HT  
HT begin Enter high temp state Event A AND Event B HT HT change 
HT end Leave high temp state Event A AND Event B not HT HT change 
 
The “HT change” event detects when the system is flipping between “temperature OK” and “too hot”.   It 
detects a change in either direction, but cannot by itself tell which direction the system is changing.   To 
determine the direction a second event is needed. 
 
The “HT begin” event detects when the system is going from “temperature OK” to “too hot”.   If the high 
temperature state has changed (the “HT change” event) AND the system is in the high temperature state 
(the “HT” event) then the system has just changed from “temperature OK” to “too hot”. 
 
The “HT end” event is similar to the “HT begin” event, except it detects the change from “too hot” to 
“temperature OK”.   It isn’t needed if all you want to do is perform an action on the switch from “temperature 
OK” to “too hot”. 
 
To send an SMS when the system becomes hot, add the “SMS” instrument to the scheme, configure the 
message, then add the corresponding dialout group as the Output for the “HT begin” event. 
 
Note that if all you wanted to do was send the message when the system became too hot, and didn’t need to 
worry about when it cooled down, you’d be able to discard the “not HT” event, leaving the following five 
events: “HT upper”, “HT lower”, “HT”, “HT change” and “HT begin”.   If you DID want to send a “cooled down” 
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message, then you’d leave in the “not HT” and “HT end” events, create a second message on the SMS 
instrument, then set the “HT end” output to activate that second dialout group. 
 
To summarize: 
 
Name Description Event A B Output 
HT upper High temp on Channel A > B Internal Temp 55  
HT lower High temp off Channel A < B Internal Temp 50  
HT High temp state On Event A Until Event B HT upper HT lower Cooling on 
not HT Not high temp Not Event A HT  Cooling off 
HT change High temp state change Delta Event A HT   
HT begin Enter high temp state Event A AND Event B HT HT change High temp SMS 
HT end Leave high temp state Event A AND Event B not HT HT change OK temp SMS 

Saving the Scheme 
Save your scheme by clicking on the Save icon (shown to the right). 
 
If you’ve saved your scheme before it will immediately save.   If you’ve never saved the scheme before, the 
dialog shown below will appear.   You can get the same dialog at any time by selecting Save Scheme As 
from the File menu. 
 

 
 
Enter the scheme name in the File Name field.   There is a maximum length of eight characters. 
 
The New Group button allows you to create sub-folders of schemes.   Groups may be created inside 
groups, too. 
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Programming Loggers 
Loggers can be divided into two types: Standard Loggers and Neon Loggers. 
 
Standard loggers are programmed directly with Starlog V4 via a serial cable, while Neon loggers 
are programmed through the Neon web interface. 

Standard Loggers 
Standard loggers are programmed from the main screen, by clicking on Program under the Logger menu, 
or by clicking on the Program icon, shown to the right.   You will be asked to confirm before the programming 
will proceed: 
 

 
 
Clicking OK will open a new window that shows the progress of the programming: 
 

 
 
If all goes well, a Logger successfully re-programmed message will appear (with Disconnected as 
the final message).   Click OK to close the progress window. 

Neon Loggers 
Neon loggers are programmed through the Neon web interface.   These include Neon Remote Terminals 
(NRTs) and Neon Metering Modules (NMMs).   Starlog must be configured to generate Neon files.   See 
General Options on page 11.   The “Generate Neon upload file” option must be ticked. 
 
In the Neon web interface, select the Loggers tab of your node, then under the Internal Logger tab, select the 
generated “.neon” file for your scheme.   Click the “Upload” button to send it to Neon.   The screenshot below 
highlights the important controls: 
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To force the scheme to be loaded immediately by the logger, the Starlog Configure/Initialise tool 
should be used.   See the icon to the right. 
 
Connect the Neon logger to the computer using a serial cable.   Click the “Retrieve NRT 
Settings” button to get the current settings, and then click the “Initialise” button to have the 
logger to synchronise with the Neon server and start using the scheme loaded above. 
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Test Mode 
Test Mode is used to check the status of the logger, and to monitor its logging progress. 
 
To enter Test Mode, click on Test Mode under the Logger menu, or click on its icon (shown to 
the right).   A window similar to the following will appear: 
 
 

 
 
The Scheme Name shows the name of the scheme that has been programmed into the logger.   If the 
scheme in the logger isn’t the same as the currently selected scheme, the following message will be 
displayed: 
 

 
 
You should select the named scheme (in this case “Demo”) and load its Test Display. 
 
The entire display may be zoomed by pressing the + (plus) or = (equals) keys.   To un-zoom the display, 
press the – (minus) key.   This is also accessible from the Text Size menu item of the Test Mode menu. 
 
The Test Mode window is divided into four sections: 
 
1. Scheme Information 
2. Log Information 
3. Scheme Channels 
4. Log Buffers 
 
Each of these items is explained in detail below. 

Scheme Information 

 
 
The Scheme Information section has the following items: 
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• Scheme Name: The name of the scheme programmed into the logger. 
• Logger Time: The date/time of the logger. 
• Logger State: One of Primed, Logging, or Stopped: 

1. Primed: The logger hasn’t yet started logging.   Loggers with no built-in instruments (excluding internal 
battery and temperature sensors) will not start logging until three scans have passed since a plug was 
connected to their “Input Signals” connector. 

2. Logging: The logging is sampling and recording data. 
3. Stopped: The logger is not recording.   This may be because the inputs have been unplugged, or the 

logger Main Buffer has filled (only applicable to Linear types, see Other Buffer Settings on page 28). 
• Scan Rate: The time between consecutive samples of the inputs. 

Log Information 

 
 
The Log Information section has the following items: 
 
• Log Rate: This is the time between consecutive logs. 
• Log Size: This is the size of each log entry in the Main Buffer in bytes. 
• First Log: This is the date/time when the first log was recorded. 
• Last Log: This is the date/time when the most recent log was recorded. 
• Memory Expires on: This is the estimated date/time when the Main Buffer will fill up and either stops 

logging (Linear) or starts overwriting the oldest data (Circular).   How long it will take to reach that 
date/time is shown in brackets. 

• Memory Usage: This shows how much of the loggers buffers are currently being used. 

Scheme Channels 

 
 
The Scheme Channels display the current readings of the instruments connected to the logger.   Double-
click on the display field to set the corresponding value on the logger. 
 
The available channels may be changed via the Edit Channels item of the Test Mode menu.   Selecting 
that item will open the following window: 
 

 
 
Channels defined in the scheme cannot be edited or deleted, but you are able to define your own channels.   
Click the Add button to create new channels.   Clicking the Delete button will delete the selected custom 
channel.   The channel parameters are: 
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• Channel Label: The label of the channel.   It is shown in front of the value field. 
• Units: The display units of the channel.   It is shown after the value field. 
• Input Data Type: Specifies how the channel data is stored in the logger.   One of: 
o Unsigned Byte: One byte.   Has the range 0…255. 
o Signed Byte: One byte.   Has the range -128…127. 
o Unsigned Word: Two bytes.   Has the range 0…65,535. 
o Signed Word: Two bytes.   Has the range -32,768…32,767. 
o Unsigned Long: Four bytes.   Has the range 0…4,294,967,295 
o Signed Long: Four bytes.   Has the range -2,147,483,648…2,147,483,647. 
o String: Variable number of bytes.   The end of the string is marked with a zero byte. 
o Floating point: Single precision floating point.   Four bytes.   Has the range ±3.4×10-38…±3.4×1038 and 

7-digit precision.   Note that Unidata data loggers cannot process floating point data – it cannot be 
totalised or averaged.   It is currently supported only for reading SDI-12 sensors. 

• Base Address: 
• Protected(CDT): Indicates that this channel is reading protected logger memory, typically a configuration 

setting. 
• Number Bytes: The number of bytes required to store the channel value.   This field is only editable for 

string Input Data Types; it otherwise corresponds to the selected Input Data Type. 
• Multiplier: The amount to multiply the logged data before displaying.   The Multiplier is applied before the 

Offset.   The multiplier is independent of any logger bit scaling – for analogue channels the multiplier is 
applied to the mV reading of the channel. 

• Offset: The amount to add to the logged data before displaying.   The Offset is applied after the Multiplier. 
• Formula: Some applications require a formula to transform logged data into a viewable form. 
• Format: The display format of data associated with this channel.   Allowed characters are: “#” (hash), “0” 

(zero) and “.” (decimal point).   A “#” will reserve space for a digit (zeroes will be shown as spaces), a “0” 
will always show a digit in that position. 

 
To save your changes into the scheme files, select the Save option from the File menu.   Note that when 
you next save the scheme in the scheme editor, your changes will be lost. 

Log Buffers 

 
 
The Log Buffers are displayed across the bottom half of the window.   The Main Buffer plus any Event 
Buffers are each given their own tab.   Click on the tab to select the buffer to view. 
 
Each buffer viewer operates in one of two modes: 
 
• Table: This displays the logged data in tabular form. 
• Graph: This display the logged data in a graphical form as a line plot of data.   Each logged item forms a 

series and each can be individually turned on and off. 
 
Select the mode using the Logged Data option under the Test Mode menu. 

Log Buffer Table View 
This is the default Log Buffer view.   Each column is a different logged data item.   Each row is a log record. 
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To change to the Graph view, right-click anywhere over the table data and select Graph from the menu. 
 
To change the number of log records shown, right-click anywhere over the table data and select the required 
number of records from the View sub-menu.   The data selected is always from the most recently logged 
records.   Since 100 records is the largest number available, data logged more than 100 records ago cannot 
be viewed in Test Mode.   You will have to unload the logger to see older data. 

Log Buffer Graph View 
The Graph View displays the logged data in the form of a series line plot.   Each logged item forms a 
different series.   The time of log is the X-axis, the Y-axis is the value of the logged items. 
 

 
 
To change to the Table view, right-click anywhere outside the plot area (either of the axes or the Last N 
records title) and select Table from the menu. 
 
To change the number of log records shown, right-click anywhere outside the plot area (either of the axes or 
the Last N records title) and select the required number of records from the View sub-menu.   The data 
selected is always from the most recently logged records.   Since 100 records is the largest number 
available, data logged more than 100 records ago cannot be viewed in Test Mode.   You will have to unload 
the logger to see older data. 
 
To adjust which data series are plotted, either use the checkboxes to the right of the plot area, or right-click 
in the plot area and select/deselect the series from the Filter sub-menu. 
 
To see the specific value at a point on the graph, move the mouse over the graph and line up the vertical line 
that moves with the mouse pointer over the point of the graph that you’re interested in.   After a short delay a 
popup tooltip will appear showing the date/time and value of the data at that position. 
 
The following shows that at 18/11/2008 14:50:00 a value of 8.61 was logged: 
 

 
 
Note that the mouse doesn’t have to be on the plotted line – any position vertically above or below, but inside 
the graph area, will work. 

Menu Commands 
When in Test Mode, a new main menu item called Test Mode is made available.   The commands are: 
• Correct Time: Programs the logger with a time correction factor that over a period of time adjusts the 

internal logger clock to the correct time.   This correction may take hours or even days, depending on the 
size of the correction and the logger scan rate. 

• Put Value: Allows you to put a specific byte value at a specific address in logger memory. 
• Edit Channels: See Scheme Channels on page 36. 
• Logged Data: See Log Buffers on page 37. 
• Text Size: Allows selection of Normal (the default) or High Visibility (large) sized text in the test 

display. 
• Stop Logging: This will stop the logger scheme and put the logger to sleep.   The logger can only be 

restarted by re-programming it. 
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Unloading Data from Loggers 
Once you’ve had your logger operating for a while, it will have recorded some data.   Unloading is the action 
of copying the data stored in the data logger into a file on your PC. 

Unload File Format 
Unload files are CSV (comma separated value) files.   CSV files can be directly opened in Excel, and are 
also a common format supported by other software such as Tideda and Hydsys. 
 

NOTE: Version 4 software can only produce CSV files, it cannot generate Version 3 compatible 
*.Unn files. 

Automatic Backups 
The unloader supports the creation of backup unload files automatically at the time of unload.   The backup 
folder is specified by the Backup Data Path option (see General Options on page 11).   Version 4 and 
Version 3 schemes handle backups slightly differently.   See their respective Data Folders sections below. 
 
If the backup media is not available at the time of unload, Starlog V4 will display an error message and you 
can either retry the backup, or cancel it.   If you cancel it, you will have to manually backup the unload file 
yourself at a later time. 

Version 4 Data Folders 
Data unloaded for Version 4 schemes is stored in a buffer sub-folder in a scheme sub-folder of the folder 
specified by the Data Path option (see General Options on page 11).   For example, if the Data Path is the 
default of “C:\Program Files\StarlogV4\DATA\”, the scheme name is “TinCreek” and the data was 
logged in the main buffer, then the CSV files will be stored in the folder 
“C:\Program Files\StarlogV4\DATA\TinCreek\Main Buffer\”. 
 
Backup data is handled similarly.   If the backup path is set to “E:\”, backup CSV files for the example above 
would be stored in “E:\TinCreek\Main Buffer\”. 

Version 3 Data Folders 
Data unloaded for Version 3 schemes is stored in a scheme sub-folder of the folder specified in the Starlog 
V3 Data Path option.   See Starlog V3 Options on page 14.   For example, if the V3 Data Path is 
“C:\STARLOG\DATA\” and the scheme name is “DEMO”, then the CSV files will be stored in the folder 
“C:\STARLOG\DATA\DEMO\”. 
 
Backup data is handled slightly differently.   If the backup path is set to “E:\”, backup CSV files for the 
example above will be stored in “E:\” (there is no scheme sub-folder). 

File Naming Convention 
Unload files are named according to the configured file naming convention.   By default unload filenames 
include the scheme name and unload index number, but may be configured to also include the site ID and 
date/time.   See Data Options on page 12. 

Unload Procedure 
To unload logged data from your data logger to your PC, click on Unload Data under the 
Logger menu, or click on the Unload icon (shown to the right).   The following window will 
appear: 
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If your scheme has defined multiple buffers, you must unload each one in turn.   There are three options for 
downloading each buffer: 
 
1. Full Unload: This unloads all the data available on the logger into a new CSV file. 
2. Partial Unload: For fixed log interval buffers, this unloads all the data between two dates into a new CSV 

file.   For event-based buffers, this unloads into a new CSV file a selectable number of log records, starting 
at the most recent. 

3. Incremental Unload: This unloads all data logged since the last time you unloaded the logger.   If you’ve 
never unloaded the logger since you programmed it, this will be a Full Unload.   Tick the Append to 
current file checkbox if you want the data to be appended to the most recently unloaded data, 
otherwise the data will be stored in a new file. 

 
When you have selected the unload method you want, click the Unload Data button.   If you have ticked 
Unload Comment in the StarlogV4 Data Options (see Data Options on page 12), then a dialog will pop up 
asking you to enter a comment: 
 

 
 
While data unloads, a window will appear showing you the progress of the unload: 
 

 
 
When the unload completes, several things occur: 

• You are asked if you want to save the current log record position for the next incremental unload.   
See the Incremental Unload option above. 

• If you have a backup path set (see General Options on page 11) a copy of the just unloaded data will 
be stored under the specified path. 

• The just unloaded data will be added to the list of files: 
 

 
 
You can view a CSV file by double-clicking on it in the list.   See Viewing Data on page 41 for a complete 
description of viewing logged data. 
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Viewing Data 
Starlog is not data processing software.   We recommend that you use Tideda, Hydsys, or Magpie to process 
data.   The data viewer is for functional testing only. 
 
To view data that you have previously unloaded, click on Data Viewer under the Logger 
menu, or click the View Data icon (shown to the right).   The following window will appear: 
 

 
 
Initially, only the Source Data File tab is available.   This is where you select the data you want to view. 

Source Data File 
Before selecting the file to view, you must first select the type of data you want to view.   There are four 
supported types: 
 
1. StarlogV4 (*.CSV): Version 4 data files generated by version 4 software from version 4 schemes. 
2. StarlogV3 (*.CSV): Version 4 data files generated by version 4 software from version 3 schemes. 
3. StarlogV3 (*.Ann): Version 3 data files generated by version 3 software. 
4. Archive (*.CSV): Arbitrary CSV files. 
 

NOTE: Version 4 cannot directly view Version 3 unload files.   Before you can view Version 3 data, 
you must create *.Ann files for each *.Unn file using an ASCII report created in the Version 3 
Report Editor and then displaying that report in Version 3 to create the file(s). 

 
Selecting the type of data will change the tree of available files in the bottom of the window. 
 
The first line of the window will show the folder that Starlog V4 is looking in for data files.   In the sample 
screenshot above Starlog V4 is looking under C:\Program Files\StarlogV4\DATA. 

Starlog V4 (*.CSV) Files 
These files are grouped by scheme, each scheme will have one or more buffers, and each buffer will have its 
own set of logged data files. 
 
The following screenshot shows that there is a scheme called Demo, which has available data from its Main 
Buffer, and the only data file available is a file called Demo_01.CSV. 
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Starlog V3 (*.CSV) Files 
These files are all the CSV files, grouped by scheme, stored in the scheme folders under the folder specified 
by the Starlog V3 Data Path (see Starlog V3 Options on page 14). 
 
The following screenshot shows a single scheme called SDITEST with a single data file called 
SDITEST_01.CSV: 
 

 

Starlog V3 (*.Ann) Files 
These files are all the *.Ann files stored in the folder specified by the StarlogV3 Schemes Path (see 
Starlog V3 Options on page 14).   They are listed in alphabetical order, but not grouped by scheme. 
 
The following screenshot shows files from five different schemes (ERAGC2 (4 files), ERAGCMBL (1 file), 
ERAJABWA (1 file), ERAMAG01 (4 files), and ERAMAG28 (1 file)): 
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Archive (*.CSV) Files 
These are whatever CSV files Starlog V4 can find in the specified folder.   CSV files to be viewed in the Data 
Viewer have some formatting requirements: 
 
• The first line in the file assigns a name to each column consisting of the channel name and the logging 

method (raw, average, etc). 
• The second line in the file assigns the units to each column (mm, degC, etc). 
• The third line and beyond is the unloaded data. 

Viewing the Data File 
Once you’ve located the data file you want to view, there are a number of ways to open it: 
 
• Double-click on it to open it using the Starlog V4 built-in Data Viewer (see Opening with the Built-In Data 

Viewer below). 
• Right-click on it to open a context menu: 
 

  
 
The “Open with” options are described below.   The Send To, Copy, Delete, and Open containing folder are 
all handled exactly the same as when you right-click on a file in the standard Windows file Explorer. 

Opening with the Built-In Data Viewer 
Opening a data file using the built-in data viewer will open the file in the Graph View.   There is also a 
Table View where you can view the data as text.   You can freely switch between these two modes and 
the Source Data File mode (see Source Data File on page 41) by selecting the appropriate tab at the 
top of the window. 

Graph View 
The default mode for viewing your data is the Graph View.   This shows a zoomable graph on the left and 
graph control buttons on the right.   The legend may be moved by dragging it to a new position. 
 
The graph is zoomable by clicking and dragging out the rectangular area you want to zoom in to.   Reset the 
zoom by right-clicking on the graph.   The zoom level is also reset when you make a change to the visibility 
of any channel. 
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When you hover your mouse over the graph, the time of log of the data you’re hovering is shown at the 
bottom left, next to the scrollbar. 
 
The example below has the Battery channel turned off, leaving the Internal Temp.   It also shows the hidden 
controls that appear when the Channel Filter, Cumulative Totals, and Set Y-Axis buttons are pressed: 
 

 
 
The Channel Filter controls which channels are plotted on the graph. 
 
For each Cumulative Total item that is ticked, a new series is added to the graph that plots the cumulative 
total of the values of the selected channel. 
 
The Set Y-Axis button opens a list of channels titled “Use 2nd Y-Axis”.   Each channel ticked is taken into 
consideration when determining the scaling used for the 2nd Y-Axis that runs down the right side of the 
graph. 
 
The Print button will print the graph.   The Save buttons allows the graph to be saved as a Windows Bitmap 
(BMP) file. 

Text View 
The Text View shows your logged data in a tabular form.   The column widths are adjustable by dragging 
the divider between them.   Use the scroll bar to select the data to view. 
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Opening with Notepad 
Opening your data file in Notepad can be useful if you suspect some file corruption.   Notepad doesn’t try to 
interpret the data, so you can scan through it and manually correct any anomalies. 
 

 

Opening with Excel 
Opening your data in Excel gives you a lot more power to display, format, print, and analyse your data.   
When opened in Excel, two sheets are created; the first one is for viewing the data in a tabular format: 
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There is also a second sheet called “filename_Chart” that displays the data as a graph: 
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Diagnostics 
Diagnostics are accessed from the main Starlog V4 window by selecting the Diagnostics tab on 
the left toolbar.   See the screenshot to the right: 
 
Diagnostics provides several functions to assist you with various problems you may encounter 
using data loggers.   Each function is explained below: 

Comms Window 
The Comms Window function may be accessed by clicking the Comms Windows item under the 
Logger → Diagnostics menu, or by clicking the icon shown to the right.   It allows you to watch 
the communications between your PC and your data logger.   You can watch the progress of logger 
programming or unloading, or you can watch the commands issued during the test display. 
 
The Comms Window is frequently useful for diagnosing modem problems and logger baud rate mismatches. 
 

 
 
Data sent from the PC to the logger is shown in green, while data sent from the logger to the PC is shown in 
blue.   The above screenshot shows communications that result from a typical test display.   If no 
communication was taking place, you’d just expect to see regular star (asterisk ‘*’) prompts from the logger. 
 
The top of the window lets you control the serial port, and provides some status indicators: 
 
• Connect/Disconnect: Click to connect/disconnect to/from the selected communications port. 
• NRT Menu: Provides access to the NRT configuration menu. 
• Diagnostics: This will activate the logger diagnostics mode. 
• SDI-12 Test: This will enter the SDI-12 Test mode.   See SDI-12 Test on page 51 for more information. 
• Initialize: This will reinitialise the logger.   If the logger is asleep, this will wake it up.   The scheme and 

logged data are not affected. 
• Reset: This will reset the logger to its default configuration. 
• Edit Address Book: See Address Book on page 48. 
• Direct to COM1: Selects the type of communications port to use.   Different selections affect what 

remaining controls are visible: 
o Direct to COMx: Physical RS-232 serial communications ports available on the local PC. 

 Comm Port: The local communications port to use. 
 Baud rate: The baud rate to use.   If no star prompts are detected, the software will automatically 

cycle through all the baud rates until a star prompt is detected. 
 DTR: Controls the Data Terminal Ready signal.   Modems require this signal to be on (ticked) to 

enable dialling out to other modems. 
 RTS: Controls the Request To Send signal.   Unidata data loggers require this signal to be on 

(ticked) to wake up for communication. 
 DSR: Indicates the current state of the Data Set Ready signal.   The DSR state usually reflects the 

DTR signal. 
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 CTS: Indicates the current state of the Clear To Send signal.   The CTS state usually reflects the 
RTS signal. 

 CD: Indicates the current state of the Carrier Detect signal.   Modems turn this signal on when they 
are connected to another modem. 

 Phone Number: The telephone number to dial when establishing the connection. 
o Network (UDP): Virtual communications ports provided over a TCP/IP network. 

 IP Address: The TCP/IP address of the remote communications port. 
 Port: The TCP/IP port number of the remote communications port. 

o Use Address Book: Select a site defined in the Address Book to connect to.   See Address Book below. 
 

 

Address Book 
The Address Book allows you to manage the connection details for many sites all in one place.   It allows you 
to create a single generic scheme, and then connect to many different sites to use it. 
 

 
 
Sites can be gathered into groups.   Groups may contain other groups.   Create groups by first selecting 
either the top-level “Address Book” item or the containing group.   Then click “Add Group” on the toolbar. 
 
Add sites by selecting the top-level “Address Book” item or the containing group, then click “Add Site” on the 
toolbar. 
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Enter the site name, select the communications device and click OK.   Suitable default parameters for the 
selected communications device will already have been filled in.   Other parameters will need to be set.   For 
sites that connect directly to a serial port or modem, the important parameters are: 
• RESET: The command string used to initialize the modem.   A typical setting would be “ATZ”, the 

modem initialization command. 
• SETTINGS: The command string used to set any further modem parameters.   A typical setting might be 

“ATE0” to turn off local echo on the modem, which may otherwise interfere with communications. 
• OUTSIDELINE: The number used by the modem to access an outside line through a PABX.   May be 

left blank if using a direct line. 
• PHONENUMBER: The telephone number to dial.   May be left blank for direct connections. 
• TELSWITCH: The telemetry switch code to use.   May be left blank. 

For sites that connect via a TCP/IP network (UDP), the important parameters are: 
• ADDRESS: The TCP/IP address of the remote communications port. 
• PORT: The TCP/IP port number of the remote communications port. 

 
Sites can be renamed by clicking twice on their name in the tree in the left window pane. 

Velocity Trace 
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the Logger → Diagnostics menu, or by clicking the icon shown to the right.   It is only avail
schemes built for the Starflow data logger.   The Velocity Trace allows you to examine to profile of water 
velocities detected by the Starflow. 

able for 
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The horizontal axis is the velocity in mm/s, the vertical axis is the number of samples detected.   The red line 
indicates the median velocity, which is the velocity used by the Starflow. 
 
The plus/minus magnifying glass buttons adjust the horizontal axis through a number of different scales.   
For example, the above screenshot shows all the velocity data bunched up between 0 and 1000mm/s.   The 
plus button would expand that to show greater detail. 

Upgrade Firmware 
The Upgrade Firmware function may be accessed by clicking the Upgrade Firmware item 
under the Logger → Diagnostics menu, or by clicking the icon shown to the right.   It allows 
you to upgrade the internal firmware of most Unidata data loggers. 
 
Click the Query Logger button to have the software determine what type of logger is currently connected, 
and what version of firmware it is currently running.   The following screenshot shows the results of querying 
a Yellow Memory Card Starlogger: 
 
 

 
 
• Logger Type: Shows the logger type identified by the Query Logger function. 
• Current firmware revision: Shows the firmware version currently programmed in the connected data 

logger. 
• Available Versions: Lists all the firmware available to the Starlog software that is compatible with the 

connected data logger.   You may click the Browse button to manually select an unlisted firmware, but 
updating a logger with unlisted firmware may make the logger unusable or even damage it! 
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• Query Logger: Automatically identifies the logger connected to the PC. 
• Upgrade Firmware: Click to upgrade the connected data logger to the firmware selected in the Available 

Versions field.   The window will indicate the progress of the upgrade: 
 

   
 
 

SDI-12 Test 
The SDI-12 Test function may be accessed by clicking the SDI-12 Test item under the 
Logger → Diagnostics menu, or by clicking the icon shown to the right.   It allows you to c
operation of the data logger as an SDI-12 recorder and the operation of any SDI-12 sensors connected to it.   
You are able to issue identify, measurement, and read commands. 

heck the 

 
When the window is first opened, click Connect to connect to the data logger and start SDI-12 diagnostics: 
 

 
 
Next, click Search to send identification requests to the first ten sensors.   The window will list any sensors 
found: 
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The above screenshot shows that there is a Unidata 6509C Water Level instrument, connected on address 
0, and no other instruments on any other channel. 
 
To send commands to a sensor, select it from the list, then select the command to send from the drop-down 
list (the “Measure (aM!)” in the above screenshot).   When you select a command, the actually command that 
will be sent on the SDI-12 bus is shown next to it (the “0M!” in the above screenshot).   Click Send to send 
the command on to the SDI-12 bus. 
 

 
 
If there is a response, it will appear in the communication log area, and the software will also provide an 
interpretation of the response.   The above shows the response to a Measure command, the following is the 
response to a subsequent Read: 
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Note that different sensors may return not just different values, but different numbers of values.   Most 
sensors will only return a single value. 

Configure Modem 
Configure Modem is used to program a modem with the settings appropriate for use either locally 
(to dial out to remote sites), or remotely (to be dialled into from your computer).   For example, a 
remote modem must be configured to auto-answer. 
 
Click on the icon (shown to the right) to run it.   The following window will appear: 
 

 
 
Select the correct Serial Port and Baud rate, then click Local to setup the modem for local use (i.e. to dial 
out to remote sites), or click Remote to setup the modem for remote use (i.e. to be dialled into).   A progress 
bar will fill in across the bottom of the window while the modem is identified and configured. 
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Advanced Scheme Management 

Modifying an Instrument/Sensor 
Many instruments have a specialized dialog box for adjusting their settings.   However, all instruments share 
a generic Advanced editor dialog box that allows for detailed adjustments to be made to the instrument 
configuration. 
 
Normally, the Advanced dialog should be avoided, as it is quite easy to make changes that would stop the 
instrument working.   In some cases, though, the flexibility provided by the extra settings may provide the 
exact functionality required to solve a problem. 

Accessing the Advanced Editor 
• Click on the Scheme Instruments icon. 
• Right-click on the instrument and select Advanced from the menu. 
 
Once open, a dialog with many tabs appears.   Each tab is detailed below. 

Main 

 
 
• Catalogue Code: This should uniquely identify the instrument. 
• Name: A descriptive name for the instrument.   This should be kept relatively short – put a more lengthy 

description in the Description field (below). 
• Description: A description of the instrument. 
• Instrument family: A general classification of the instrument.   Some example existing families are: 

Temperature, Climate, Time, and Communications. 
• Search Keywords: Keywords that would help someone searching for this instrument to find it.   Separate 

terms with commas. 
• Icon: An icon that should be representative of the instrument. 
• Loader Class: For use by Unidata engineers.   Do not change. 
• Setup Form: For use by Unidata engineers.   Do not change. 
• Read Only:  
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• Single Use: If ticked, only one copy of this instrument may be added to a scheme. 
• Source: For use by Unidata engineers.   Do not change. 

Comment [AG1]: Missing 
description 

• Version: The version of the instruments.   Set as required for your own instruments, but do not change the 
version of the included instruments. 

• Visibility: For use by Unidata engineers.   Do not change. 
• Base Class: For use by Unidata engineers.   Do not change. 
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Channels 
This page lists the defined Channels.   The columns are the Label, Key, and Alias for each channel. 
 

 
 
• Add: Add a new channel definition. 
• Edit: Edit the selected channel definition. 
• Delete: Delete the selected channel definition. 
 
The Add/Edit buttons take you to the Advanced Channel Parameters dialog: 
 

 
 
• Label: This is what is shown to identify the channel in other dialogs in the software (such as the Log 

Buffer) and in the Data Viewer. 
• Units: The display units of the channel. 
• Key: An optional identifier.   If present, it must be unique within the instrument. 
• Channel Type: One of: 
o User: A user-defined channel, typically the result of some scheme calculation. 
o Analogue: An analogue (voltage) input. 
o Counter: A pulsed (digital on/off) input. 
o HSIO: A high-speed, synchronous serial digital input. 
o SDI-12: A serial digital input, using the standard SDI-12 protocol. 
o State: An input that is either on or off. 
o Internal: An internal channel, such as the battery voltage, or internal temperature sensor. 

• Alias: A unique identifier used to identify the channel in code.   This is made available to scheme source 
code files for them to refer to the channel data, so the identifier must be legal in the scheme language 
code. 

Unidata Manual - 6308 Starlog V4 SW Manual Issue 2.7 55 



Starlog V4 Software – Model 6308  Unidata Pty Ltd 

Unidata Manual - 6308 Starlog V4 SW Manual Issue 2.7  56 

• Format: The display format of data associated with this channel.   Allowed characters are: “#” (hash), “0” 
(zero) and “.” (decimal point).   A “#” will reserve space for a digit (zeroes will be shown as spaces), a “0” 
will always show a digit in that position. 

• Icon: An icon that represents the channel function. 
• Use Logger Channel: For Channel Types (see above) other than “User”, this selects which of the 

channels of the selected Type to use for this channel. 
• Multiplier: The amount to multiply the logged data before displaying.   The Multiplier is applied before the 

Offset.   The multiplier is independent of any logger bit scaling – for analogue channels the multiplier is 
applied to the mV reading of the channel. 

• Offset: The amount to add to the logged data before displaying.   The Offset is applied after the Multiplier. 
• Ignore Logger Scaling: If this is ticked, then any logger bit scaling is ignored.   Use this option if you are 

handling any scaling in custom code. 
• Formula: Some applications require a formula to transform logged data into a viewable form. 
• Base Address: Only available if Virtual (see below) is not ticked.   This specifies the memory address of 

the channel data. 
• Virtual: If ticked, the channel allocated its own memory to store its data.   If not ticked, the data is read 

from an existing source (the Base Address, see above). 
• Protected (CDT): Indicates that this channel is reading protected logger memory, typically a configuration 

setting. 
• Input Data Type: Specifies how the channel data is stored in the logger.   One of: 
o Unsigned Byte: One byte.   Has the range 0…255. 
o Signed Byte: One byte.   Has the range -128…127. 
o Unsigned Word: Two bytes.   Has the range 0…65,535. 
o Signed Word: Two bytes.   Has the range -32,768…32,767. 
o Unsigned Long: Four bytes.   Has the range 0…4,294,967,295 
o Signed Long: Four bytes.   Has the range -2,147,483,648…2,147,483,647. 
o String: Variable number of bytes.   The end of the string is marked with a zero byte. 
o SP Floating point: Single precision floating point.   Four bytes.   Has the range ±3.4×10-38…±3.4×1038 

and 7-digit precision.   Note that Unidata data loggers cannot process floating point data – it cannot be 
totalised or averaged.   It is currently supported only for reading SDI-12 sensors. 

o DP Floating point: Double precision floating point.   Eight bytes.   Has the range ±1.7×10-

308…±1.7×10308 and 15-digit precision.   This data type is provisional – there is no support for it in the 
current software. 

• Number Bytes: The number of bytes required to store the channel value.   This field is only editable for 
string Input Data Types, it otherwise corresponds to the selected Input Data Type. 

• Allocate Total bytes: The number of bytes to allocate to a totaliser (accumulator) of the channel data.   
Totalising small data sizes (such as the one or two-byte sized types) may overflow a similarly-sized value.   
In that case, this field is used to request the scheme totalise into a larger sized value.   For example, it is 
recommended to totalise one-byte channel data into two-byte sized values, and to totalise two-byte 
channel data into four-byte sized values.   This field will be disabled if the Log Mask (see below) does not 
have Total ticked. 

• Enabled: If ticked, this channel is available for data logging.   If unticked, this channel is not available, but 
all of its details are still stored in the scheme. 

• Log Mask: The Log Mask indicates which Log Buffer channel options are available for this channel.   For 
example, it doesn’t make any sense to totalise temperature, or average time.   Select the options that 
make sense for the type of channel data.   See Instrument Channels on page 27. 

• Channel Visibility: This controls the places where the channel is made available. 
o LCD: If ticked, the channel will be displayed on the logger LCD. 
o Log Buffer: If ticked, the channel is shown in the Log Buffer window.   See Log Buffer on page 27. 
o Test Mode: If ticked, the channel will be visible in the Test Mode display.   See Scheme Channels on 

page 36. 
o Setup: If ticked, the channel will be visible in the setup dialogs of other instruments.   For example, if this 

is not ticked, the channel will not be available to instruments such as the GSM Voice Synthesizer, but will 
still be available for events. 
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CDT 

 
 
This page lets you set data logger configuration options.   The exact options available depend on the data 
logger – refer to its technical manual for details. 
 
• Key: This is the name of the configuration option being set. 
• Address: The CDT address of the configuration option. 
• Mask: The bit mask of the configuration option.   Some logger options share memory with other options.   

The Mask ensures the bits for the option in question are altered.   For each bit position in the Mask value, 
a 1 indicates the corresponding configuration bit may be altered, a 0 indicates it cannot. 

• Value: The configuration value to set.   Only the bits in the value that correspond with 1 bits in the Mask 
are copied to the logger configuration. 

• Add: Adds a new CDT entry. 
• Delete: Deletes the selected CDT entry. 

INP Code 

 
 
This page provides a text editor to allow entry of custom input code.   In general, only Unidata engineers will 
use this.   The following special keyword replacements are supported in this field: 
 

Keyword Description 
[Channel(“channel-key”).Alias] A unique label for referring to the channel instance. 
[Key] A unique label for referring to the instrument instance.
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Outputs 

 
 
This page is where you maintain the list of outputs of the instrument.   Custom outputs can be used to 
leverage off existing event functionality without the need for custom coding.   Because of the complexity of 
generating outputs most (if not all) of your instruments will not have any outputs at all.   However, some, like 
the 6543 Babelstar in the screenshot above, define some outputs. 
 
• Add: Adds a new default output.   Press Edit to set it up. 
• Edit: Edits the selected output.   See below. 
• Delete: Deletes the selected output. 
 
When you click Edit for an output, the following window appears: 
 

 
 
• Name: The name of the output. 
• Key: The key identifying the output. 
• Description: The description of the output 
• Logger Output Channel: The logger output channel this output will use. 
• Load To Scheme: When ticked, the output will be made available in the scheme editor as an event output.   

Note that this only occurs when the instrument is first added to a scheme from a library. 
• Key Unique: When an output is automatically loaded into the scheme and Key Unique is set then the 

output Key is preserved.   If the Key conflicts with another output then the instrument can’t be added to the 
scheme.   If Key Unique isn’t set then when the output is added to the scheme then the output Key may be 
altered to ensure that it doesn’t conflict with any other outputs. 

• TRUE code: The scheme code to execute every scan when the event that controls this output is true.   If 
the output is not referenced by any events, the code will not be executed.   Intended for use only by 
Unidata engineers. 
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• FALSE code: The scheme code to execute every scan when the event that controls this output is false.   If 
the output is not referenced by any events, the code will not be executed.   Intended for use only by 
Unidata engineers. 

• Resource List: This allocates resources to the output.   See Resources on page 60. 

Events 

 
 
System developers can build events into instruments to simplify scheme development by other users.   The 
predefined events can be automatically loaded into a scheme when the instrument is added to the scheme – 
hence the user is not required to edit events in the Scheme Editor. 
 
Alternatively, events can be embedded into the instrument to provide the same functionality, but are hidden 
from the Scheme Editor Events window.  
 
• Add: Adds a new default event to the list. 
• Edit: Edits the selected event.   See below. 
• Delete: Deletes the selected event. 
 

 
 
• Event: 
o Name: The name of the event. 
o Key: The key identifying the event. 
o Description: The description of the event. 
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o Public Event: When the instrument is added to a scheme from a library, if Public Event is selected then 
the Event will be loaded into the scheme events window.   If Public Event is not selected then the event 
will remain hidden (but active) in the instrument. 

o Preserve Unique Key: If Public event is selected, when the event is loaded into the scheme the Event 
Key will be preserved.   If the Event Key conflicts with an existing event then the instrument won’t be 
loaded into the scheme. 

o Event: The type of event.   See Types of Events on page 29. 
o Channel A: Depending on the event type this is the Channel or Event Key to bind to.   See the 

parameter formats below. 
o Channel B: Depending on the event type this is the Value, Channel or Event Key to bind to.   See the 

parameter formats below. 
o Channel C: Depending on the event type this is the Value, Channel or Event Key to bind to.   See the 

parameter formats below. 
o Output: Key to the Output to trigger on the event 
o Force Log to Buffer: Key to the Log Buffer to force a log to. 

• True Code: Scheme code to execute every scan this event is true.   This is intended only for use by 
Unidata engineers. 

• False Code: Scheme code to execute every scan this event is false.   This is intended only for use by 
Unidata engineers. 

 
Parameters have special formats that depend on the type of parameter: 
• Channel: INSTRUMENTKEY|CHANNELKEY 
• Event: INSTRUMENTKEY|EVENTKEY for non-public events or EVENTKEY for public events 
• Output: INSTRUMENTKEY|OUTPUTKEY for non-public outputs or OUTPUTKEY for public outputs 
• Log Buffer: LOGBUFFERKEY 

Resources 

 
 
Resources are used to control how logger facilities are shared among many instruments.   Some resources 
cannot be shared.   By identifying which resources are used, the software can prevent any conflicts. 
 
• Add: Adds a resource to the list. 
• Delete: Delete the selected resource from the list. 
• Resource: The identifier of the resource.   Use the Find button to select the required resource. 
• Lock: One of the following: 
o None: Resource may be shared by any number of instruments. 
o Exclusive Lock: Resource can only be used by one instrument. 
o Not Available: Resource is disabled and can’t be used at all.   For example, when a logger is set to SDI-

12 sensor mode, all SDI-12 master channels are set to Not Available. 
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Buddies 

 
 
Buddies are other instruments that this instrument requires to operate.   For example, the WINDOW 
instrument (which operates a window of start and end times for activities), requires the RELTIME instrument 
in order to tell the time.   RELTIME is added as a buddy of the WINDOW instrument.   When you add an 
instrument with buddies to your scheme, those buddies are automatically added to your scheme too. 
 
• Add: Adds a buddy to the instrument. 
• Delete: Deletes the selected buddy from the instrument. 

Files 

 
 
The Files page lists extra files associated with the instrument. 
 
• Add: Adds a file to the list.   Select the appropriate file type after adding. 
• Delete: Deletes a file from the list (does not delete the actual file!). 
• File Type: One of the following: 
o Document: Documentation associated with the instrument, such as a user manual. 
o Dependancy: Advanced users can write extensions such as custom dialogs or processing to the 

instrument using Visual Basic, C++ etc.   These extension files marked as being required by the 
instrument for correct operation. 

o Code File: Extra scheme source code associated with the instrument. 
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Loggers 

 
 
This page sets which loggers this instrument is relevant to.   The instrument will only be available to add to 
schemes that were built with one of the ticked loggers. 

Library Editors 
Starlog V4 allows you to manage libraries of pre-built instruments, systems, and loggers. 
 
While Starlog V4 comes with a comprehensive set of libraries, it is possible for you to define your own 
libraries.   You might, for example, have a standard logger setup.   You could create a library item for that to 
make creating a standard scheme for a new site as simple as a few clicks. 
 
To access the library editors, click on the library group button at the left edge of the scheme editor window: 
 

 
 

Instruments 
An instrument is a set of one or more sensors.   By creating a library of instruments, the construction of 
schemes is greatly simplified.   If you have some specialised equipment not officially supported by Unidata, 
you can create your own Instrument that tells Starlog V4 how the instrument sensors work. 
 
To access the Instruments library editor, click the Instruments icon (shown to the right).   The 
following window will appear: 
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The window is split into four main areas: 
1. Top Left: The Instrument library selector and library properties 
• Instrument Library: Select which library to work with from a list of existing libraries. 
• Name: The name of the library.   Should be unique. 
• Description: A description of the library. 
• Provider: The provider (developer) of the library. 
• Source: The filename of the library data.   This is automatically filled in when you create the library via 

the Add Library button. 
• Version: The version of the library. 
• Add Library: Click to create a new library.   You will be prompted for a filename where the library data 

will be stored.   The new file will be created, but you will have to manually select it from the list (see the 
Instrument Library field above). 

• Delete Library: Deletes the currently selected library (see the Instrument Library field above). 
• Save Library: Saves the currently selected library (see the Instrument Library field above). 

2. Bottom Left: The list of instruments in the library. 
• CatCode: The catalogue code of the instrument.   Must be unique inside the library. 
• Instrument: The name of the instrument. 
• Description: The description of the instrument. 

3. Top Right: Properties of the currently selected instrument. 
• Name: The name of the currently selected instrument. 
• Description: The description of the currently selected instrument. 
• Catcode: The catalogue code of the currently selected instrument. 
• Version: The version of the currently selected instrument. 

4. Bottom Right: Buttons to work with the instrument list. 
• Add Instrument: Creates a new default blank instrument and adds it to the end of the list of instruments 

in the library.   Click the Edit Instrument button (below) to configure it. 
• Delete Instrument: Deletes the currently selected instrument. 
• Edit Instrument: Edits the currently selected instrument.   See Modifying an Instrument/Sensor on page 

54. 

Systems 
The Systems library editor is only available in the System Developer profile.   See User Profiles on page 16. 
 
To access the Systems library, click the Systems icon (shown to the right).   The following 
window will appear: 
 

Unidata Manual - 6308 Starlog V4 SW Manual Issue 2.7 63 



Starlog V4 Software – Model 6308  Unidata Pty Ltd 

 
 
The window is split into two parts: 
 
1. Systems Collections: 
• Selector: At the top is a drop-down selector.   It lists all the available system collections.   Select which 

one you want to edit. 
• List: The list shows the systems that are defined in the selected system collection. 
• Add System: Adds a new default system to the currently selected collection.   You will need to pick it 

from the list, and then configure it using the System Editor in the right side of the window (see below). 
• Delete System: Deletes the currently selected system. 

2. System Editor: The System Editor is split into four tabs: 
1. System 

Name: The name of the system. 

eme source code files that form the core of the system.   The 

rowse button to select a custom icon file if none of 

on which the system can be based. 

nds) that the system supports.   The 
scheme editor will limit the selection of scheme scan rates to this list. 

 
• 
• Description: The description of the system. 
• Key: A unique identifier of the system. 
• Code Template: A list of available sch

code in the selected file forms the basis for all processing in the logger and acts as a framework onto 
which more specialised instrument code is added. 

• Icon: An icon representing the system.   Use the B
the predefined icons are suitable. 

• Logger: A list of available loggers 
• Default Log Interval (s): The default log interval of the system. 
• Scan Rates: A comma separated list of the scan rates (in seco
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2. Instruments: 
 

 
ments in the system.   Instruments in this case can inc
strument. 

• Instruments: The list of the instru lude loggers 
as well as the typical sensor-type in

 
• Parameter Name: The name of the parameter. 

Parameter Value: The value of the parameter.   Click the value to edit it. 
ompt for the parameter name before adding the newly 

• Add: Adds an instrument to the list.   You will be able to add any instrument from any of the available 
instrument libraries. 

• Delete: Deletes the selected instrument. 
 

3. Scheme 

• 
• Add: Adds a new parameter to the list.   It will pr

named blank entry to the list. 
• Delete: Deletes the selected parameter. 
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4. Logwhile Event 
 

 
 
The event defined here defines the overall control of when data logging may occur.   See the event editor 
under Events on page 59. 

Loggers 
The Loggers library editor is only available in the System Developer profile.   See User Profiles on page 16. 
 
To access the Loggers library, click the Loggers icon (shown to the right).   The following 
window will appear: 
 

 
 
The window is split into two parts: 
 
1. Logger List: This lists all the loggers available for editing. 
• Delete Logger: Deletes the selected logger. 
• Add Logger: Adds a new logger to the list.   You will be asked to enter the catcode (catalogue code) for 

the new logger.   A new logger with the entered catcode will be created.   Click on it, and then configure 
its settings in the right side of the window. 

2. Logger Editor: 
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• CatCode: The catalogue code. 
• Description: A description of the logger. 
• Icon: An icon representing the logger.   If none of the built-in icons are suitable, you may select an icon 

of your own via the Browse button. 
• Key: Unique identifier used to refer to the logger from elsewhere in the scheme. 
• Logger Type: The type of logger. 
• Name: The name of the logger. 
• Memory Size: The amount of memory in bytes available to the scheme. 
• Firmware Version: A comma separated list of firmware versions applicable to the logger.   Question 

marks are used as single-character wildcards.   Used to prevent accidentally programming a logger with 
a scheme intended for a different model logger. 

• TimeBase (ms): The time quantum of the scan rate.   The scheme editor uses this to calculate the 
correct scan rate configuration value. 

• Input Channels: 
 

 
 
o Add: Creates a new input channel and opens the editor for it. 
o Edit: Edits the selected input channel. 

 

 
 

 Name: The name of the input channel. 
 Description: The description of the input channel.   By convention it incorporates the range of the 
input channel. 

 Multiplier: Used to scale the raw binary value into conventional units, such as millivolts. 
 Offset: Used to scale the raw binary value into conventional units, such as millivolts. 
 Base Address: See Base Address on page 56. 
 Minimum Input: The minimum value of the input channel, after scaling. 
 Maximum Input: The maximum value of the input channel, after scaling. 
 Key: A unique identifier used to refer to the input channel in the scheme editor. 
 Channel Type: See Channel Type on page 55. 
 Data Type: See Input Data Type on page 56. 
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 Bytes: See Number Bytes on page 56. 
 Virtual Channel: See Virtual on page 56. 
 Format: See Format on page 56. 
 CDT: See CDT on page 57. 

 

 
 
 Required Resources: See Resources on page 60. 

 

 
 
 INP Code: See also INP Code on page 57.   The following special keyword replacements are 
supported in this INP code: 

 
Keyword Description 
[Alias] The numerical address of the channel. 
[NumberBytes] The size of the channel in bytes. 

 

 
 

o Delete: Deletes the selected input channel. 
• Output Channels: 
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o Add: Creates a new output channel and opens the editor for it. 
o Edit: Edits the selected output channel. 

 

 
 

 Name: The name of the output channel. 
 Description: The description of the output channel. 
 Key: A unique identifier used to refer to the output channel in the scheme editor. 
 Type: One of:  
• User Defined:  
• Scan independent control output:  
• Scan synchronised supply:  
• SDI-12: SDI-12 measurement requests. 
• HSIO: HSIO data output, for example, relay control modules. 
• Data:  

 CDT: See CDT on page 57.   The CDT settings listed here will be applied when the output channel is 
used. 

Comment [AG2]: Missing 
descriptions

 

 
 
 Resources: The resources associated with the output channel: 
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• Resource Key: The name of the output channel resource associated with the output channel. 
• Lock:  
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• Request Key: 
o Delete: Deletes the selected output channel. 

• Resources: The resources associated with the logger: 

Comment [AG3]: Missing 
descriptions 

 

 
 
o Add: Creates a new logger resource and opens the editor for it. 
o Edit: Edits the selected logger resource: 

 

 
 

 Key: The unique key identifying the logger resource. 
 Max Users: The maximum number of users (instruments, etc) of the resource. 
 Type: One of: 
• User: A user-defined resource. 
• Input: A logger input. 
• Output: A logger output. 
• Address: An address of some part of the logger memory. 
• Buffer: A logger buffer. 

o Delete: Deletes the selected logger resource. 

Code Editor 
The Code Editor is a tool intended to be used by Unidata engineers, or by very advanced users.   It allows 
direct access to the source code used and generated by Starlog V4. 
 
You access the Code Editor via the Scheme Editor.   Click the Code tab on the left navigation 
bar.   See the screen shot to the right. 
 
When opened, the Code Editor displays a code file navigator on the right side of the window, and several 
code file options down the left side of the window. * 

Basic File Operations 
• New File: Create a new source code file.   The new file is automatically created under the User file group 

in the code file navigator on the right. 
• Open File: Open an existing source code file. 
• Save File: Save the currently open source code file. 
• Close File: Close the currently open source code file. 
• Print File: Print the currently open source code file. 
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Code File Navigator 
The Code File Navigator (shown to the right), is visible on the right side of the window.   
It shows all the files associated with the current scheme.   The files are divided into 
three groups: 
 
1. System: The files in this group form the underlying operating system of scheme 

programs.   They define scheme code that implements the basic operation of the 
scheme, controlling instrument sampling, event processing and output triggering, 
among other things.   These files may be edited, but any changes to them will affect 
every single scheme in the system (changes will only take effect when the schemes 
are resaved).   Also, changes to these files may be lost if Starlog V4 is upgraded or 
reinstalled. 

2. Scheme: The files in this group are all associated with the specific scheme being edited.   All of the files 
are automatically generated by Starlog V4.   They may be edited, but your changes will be overwritten the 
next time the scheme is saved.   While developing instruments and template scheme, it can be useful to 
check these files to make sure the right code is ending up in the right place. 

3. User: The files in this group are also associated with the specific scheme being edited, but as they are not 
written to by Starlog V4, they may be safely edited. 

 
There is another scheme file available for viewing: the assembled listing file.   You can view this file by 
selecting List File from the Code Editor menu.   The listing file can be vital for debugging schemes, as 
it shows the complete, integrated set of source code files, line numbers, assembled binary scheme code, 
memory addresses, and listings of symbol names and values. 

Code Editor Window 
When you open a file, it is displayed in an editor window: 
 

 
 
It is a text editor, with context-aware source code colouring.   From the Code Editor menu there are 
facilities for undo/redo, clipboard, indenting, and commenting. 
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General Purpose Instruments 
See also Instruments on page 24 for a general discussion of instrument support and management. 

BUTTONS: Configurable Test Mode Buttons 
The Test Mode Button instrument lets you add buttons to the scheme test mode display that will perform a 
variety of actions. 

Requirements 
• None. 

Configuration 

 
 
• Button Type: The different button types have different parameters, explained below: 
o Set Channel: A button that will ask for a value to set the specified channel/memory when clicked. 
o PUT Value: A button that will put a specified value into the set channel/memory address when clicked. 
o Toggle Value: A button that will toggle the specified channel/memory between two values when it is 

clicked. 
• Protected Button: Protected buttons may be blocked from use via the User Profile option “Enable/disable 

locked test mode buttons” setting (see User Profiles on page 16). 
• Target: Select either “Target Channel” or “Target Address”: 
o Channel: Set the “Target Channel” to the channel to alter. 
o Address: Set the “Target Address” to the address in logger memory to be affected by the button.   Set 

the “Data Type” to the type of data at the given address. 

Set Channel Buttons 
• Button Caption: The text that will appear on the button. 

PUT Value Buttons 
• Button Caption: The text that will appear on the button. 
• Value to PUT to logger: The value sent to the logger when the button is pressed. 

Toggle Value Buttons 
• TRUE Value to send to logger: This is the value sent to the logger when the button state becomes 

“TRUE”. 
• TRUE button caption: The button text shown while the button is in its “TRUE” state. 
• FALSE value to send to logger: This is the value sent to the logger when the button state becomes 

“FALSE”. 
• FALSE button caption: The button text shown while the button is in its “FALSE” state. 
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The example shown in the configuration screenshot shows the settings for a toggle button that will restart a 
data logger logging after it has stopped, and stop the logger if already logging.   It is only suitable for use with 
event logging, where the date/time is logged with each item. 
 

    
 
While the logger is logging, the byte at address 65 has the value of 1.   That corresponds to the FALSE state, 
and so the FALSE caption “Pause” is shown.   Pressing the button toggles the state of the button to TRUE 
and Starlog will put the TRUE value (2) into the byte at address 65, then update the button to show the 
TRUE caption “Resume”. 
 
Note that the example configured the TRUE value/caption to be 2/“Resume” and the FALSE value/caption to 
be 1/“Pause”.   The opposite configuration (TRUE as 1/“Pause” and FALSE as 2/“Resume”) would have 
worked exactly the same. 

CUSTOMACTION: Custom Visual Basic Actions 
NOTE: This instrument is intended for use only by Unidata engineers.   It is documented here for 
completeness, but technical support cannot be provided for its use. 
 
The custom action instrument allows arbitrary Visual Basic code to be processed in response to various V4 
tasks.   Each task requires a Sub Main routine be defined.   The tasks are: 
 
• Before Program: Called after V4 confirms that programming will erase logger memory, but before any 

communications takes place.   Requires that Process.Continue be set to True in order for the 
programming to take place. 

• After Program OK: Called after V4 successfully reprograms and disconnects from the logger. 
• After Program Error: Called after V4 disconnects from the logger when the logger cannot be programmed 

for some reason. 
• Before Unload: Called before V4 connects to the logger to perform an unload, and before the unload 

comment is requested.   Requires that Process.Continue be set to True in order for the unload to take 
place. 

• After Unload OK: Called after V4 disconnects from the logger when the logger has been successfully 
unloaded.   Requires that Process.Continue be set to True in order for the unloaded data to be saved. 

• After Unload Error: Called after V4 disconnects from the logger when the logger cannot be unloaded for 
some reason. 

• Testmode Start: Called after V4 has connected to the logger and successfully read the display data. 
• Testmode Stop: Called before V4 disconnects from the logger.   Requires that Process.Continue be 

set to True in order to disconnect from the logger and allow the test mode window to be closed. 

Requirements 
• None. 

EVENTCNTR: Event Counter 
The event counter instrument counts the number of scans a selected event is true.   It supports a variety of 
counter sizes (larger sizes support higher maximum count values), and supports a number of different 
methods to reset the count, including never. 

Requirements 
• One event to count. 

Unidata Manual - 6308 Starlog V4 SW Manual Issue 2.7 73 



Starlog V4 Software – Model 6308  Unidata Pty Ltd 

Configuration 

 
 
• Event: The event to count. 
• Size: How big a count to support: 
o Byte: One byte, maximum count of 255. 
o Word: Two bytes, maximum count of 65,535. 
o DWord: Four bytes, maximum count of 4,294,967,295. 

• Reset: When to reset the count value to zero.   This setting may be overridden via the reset event output 
(see below). 
o Never: The counter will never be reset to zero. 
o After Logging: The counter will be reset to zero after it is logged. 
o On Event: The counter will be reset to zero when the selected event is true. 

 
In addition to the above controls, the event counter instrument creates an event output that may be used to 
reset the counter.   It is functionally identical to the “On Event” reset option above. 
 

 
 

FREQUENCY: Generic Frequency 
The generic frequency instrument lets you read any rate based input from a counter channel.   The 
instrument automatically incorporates the logger scan rate into the channel scaling so that the scaler is the 
conversion factor for degrees to required units. 
 

NOTE: The scan rate is incorporated when you click on OK.   If you later change the scan 
rate you will have to re-open the setup window to update this instrument with the new 
scan rate. 

Requirements 
• One counter channel. 
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Configuration 

 
 
• Input Channel: Select the counter channel to measure the sensor on. 
• Label: Enter a label for display in Test Mode and the Data Viewer. 
• Scaler: Enter the conversion factor for Hz to specified units. 
• Units: Enter the units for display in Test Mode and the Data Viewer. 

GENPT: Pressure Transducer 
The Generic Pressure Transducer instrument can be used to read a range of analogue pressure 
transducers.   The output will be scaled to read directly in mm based on the selected Range and Output. 

Requirements 
• One analogue channel. 

Configuration 

 
 
• Label: Enter a label for channel display in Test Mode and in the Data Viewer. 
• Input Channel: Select the channel to measure the current. 
• Range: Select the range of the sensor. 
• Output: Select the output type of the sensor. 

LOOKUP: Lookup Table 
The Lookup Table instrument lets you solve a complex mathematical function on the logger.   This could be a 
non-linear function such as a thermistor, or stage-flow relationship over a fixed weir.   Solving these functions 
on the logger offers advantages to the user such as true display of parameters on the Starlogger LCD, easy 
processing of data on the logger e.g. volume accumulation of flow, or easy transfer of true value via SDI-12, 
Modbus etc. 
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The Lookup table instrument lets you enter a formula directly and generates a lookup table that covers the 
range selected.   The instrument automatically takes into account the scaling applied to the source channel. 
 
A lookup table can use quite a large amount of memory so it’s important to only define the lookup table of the 
required range to minimize memory requirements. 

Requirements 
• None. 

Configuration 

 
 
• Result Label: Enter the label for display in StarlogV4 Test Mode and Data Viewer. 
• Result Units: Enter the units for display in StarlogV4 Test Mode and Data Viewer. 
• Pre-scale: Enter the amount to pre-multiply the values to be stored in the logger.   Since the logger can 

only store integer values, we can “pre-scale” the values by “x” and then divide the value again by “x” for 
display. 
For example, with a pre-scale of 10, a flow of 145.6 would be internally stored as 1456 and divided by 10 
for display and data unloads. 

• 2-byte: Select 2-byte if the pre-scaled results are all between 0 and 65535 (for example, the result 1456 
above qualifies). 

• 4-byte: Select 4-byte if any of the pre scaled results are more than 65535. 
• Source Channel: Select the channel to use as the input to the lookup table. 
• Table Range: Enter the range of “Source Channel” where the lookup table is valid. 
• Table Size: Select the number of bytes for the table.   A smaller table size will have less resolution but will 

require less logger memory. 
• Result =: Enter the Formula to solve.   Reference the Source Channel using its label. 
• Create Table: Click on Create Table to test the formula and generate the lookup table 
• Lookup table window: This is a display of the results of the lookup table process. 

Example – Weir Flow 
Formula Result Field 
Flow = 125.65h1.8-12.34 
Where “h” is the water height (or Depth) 

125.65*Depth^1.8-12.34 

Example – Flow Scaling 
Formula Result Field (all on one line) 
Depth is unscaled less than 100, multiplied by 1.2 between 
100 and 200, and multiplied by 1.5 above 200. 

Depth*(Depth>=0)*(Depth<100)+ 
Depth*(Depth>=100)*(Depth<200)*1.2+ 
Depth*(Depth>=200)*-1*1.5 

NOTE: Comparison operators evaluate as -1 for “true” and 0 for “false”. The “*-1” in the last result line above 
is to handle the previous condition values. 
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MINMAXTIME: Time of minimum/maximum 
This instrument allows the time of a channel minimum/maximum to be logged.   The time and corresponding 
minimum/maximum value is reset on every log. 

Requirements 
• None. 

Configuration 

 
 
The configuration is simple – select the channel for which you want to capture the minimum and maximum, 
and then click OK.   If the instrument for the selected channel has an associated picture, that picture will be 
shown on the left. 
 
Next, go to the Log Buffer window: 
 

 
 
From there you can select what to log.   Note that while you can still select the MIN / MAX boxes for the 
original channel, it is recommended that you log the RAW min/max channels of the min/max time instrument, 
as shown above. 

RELTIME: Relative Time Channels 
The Relative Time Channels provide channels for the following: 
• Time of Day (TOD) in HHMM format, e.g. 1030 = 10:30. 
• Minute of Day (MOD) in the number of minutes passed since midnight in the range 0…1439. 
• Day of Week (DOW) in the range of 0…6 (0 = Sunday). 
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Requirements 
• None. 

Configuration 

 
 
• See Advanced Scheme Management on page 54 for details on the Generic Instrument Setup Window. 

SCHEME: Embedded Scheme Information 
The embedded scheme information instrument saves some of the scheme definition inside the logger 
program, so that when the logger is programmed, the saved portion of the scheme definition is programmed 
as well. 
 
The saved scheme information can be subsequently used by Version 4 to unload the logger or display the 
test mode without needing the original scheme.   The saved data will be read from the logger and used 
directly. 
 
To use the embedded scheme information, select the “Embedded V4 Scheme” tab when selecting a 
scheme, then the “Direct Connection” item: 
 

 

Requirements 
• None. 

Configuration 
• None. 
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SCHEME_INFO: Scheme Information Report 
The Scheme Information Report instrument generates a text report of the scheme settings, instruments, log 
buffer, etc.   This report is generated whenever the scheme is saved.   To view the report, double click on the 
instrument.   A window similar to the following will appear: 
 

 
 
The report can be re-saved elsewhere, printed, etc. 

Requirements 
• None. 

Configuration 
• None. 

SDI: SDI Transducer 
The SDI transducer instrument lets you read any SDI-12 sensor connected to the data logger using the SDI-
12 protocol. 
 
The SDI instrument lets you configure the scheme to read the sensor on the specified address, retrieve the 
specified parameter set, specify the data type to store the reading in, how often the read the sensor, and 
what channels the sensor will return. 
 
If multiple SDI-12 sensors are connected to the logger then multiple SDI instruments can be added to the 
scheme.   Each instrument can be individually configured and all the sensors will be placed on a queue 
system.   If an instrument requests a read when the SDI bus is busy with another instrument then the request 
will be placed on the queue and serviced when the bus is free.   All sensors are checked on turn and 
therefore none will be “missed out” if an earlier sensor initiated another read before the previous request was 
serviced. 
 
The SDI instrument will also add an “init SDI-12 read on address a parameter n” output to the scheme 
outputs list.   If you use this output, you must select Manual as the Refresh Rate. 
 
Note that because the logger can only read one sensor at a time you have to ensure that sufficient time is 
allocated to read all sensors 
 

Warning: The settings in the instrument setup window must match the sensor i.e. Sensor 
address, number of channels returned for the instrument to function correctly.   Defining 
fewer channels than the sensor actually returns can corrupt other instrument readings on 
the logger.   Use the SDI-12 Test diagnostics mode (described on page 51) to determine 
how long the sensor will take to return a reading, and how many channels it will return. 

Requirements 
• 6004B, C or D Starlogger, Prologger or Micrologger based data logger. 
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Configuration 

 
 
• Name: Enter the name of the SDI-12 sensor (for display only). 
• Description: Enter the description of the SDI-12 sensor (for display only). 
• Address: Select the SDI-12 address of the sensor. 
• Parameter: Select the parameter set to return from the sensor.   Many sensors can return more than one 

parameter set e.g. main readings in parameter set 0 and diagnostic information in parameter set 1.   Each 
parameter set has to be treated as a separate instrument.   By default you would generally use parameter 
set 0.   This correlates to a SDI-12 measure command of “aM!”. 

• Data Type: Select the data type to use for the stored readings: 
o Integer: Store the values as 2-byte integers.   Integer values are easy to manipulate (e.g. calculate 

average), however, to convert the floating point received by the sensor to integer values the logger 
simply removes the decimal point. 

 
Therefore “123.45” becomes “12345”.   For this reason the response of the sensor must have a fixed 
number of decimal points.   Also the converted value must fit within the range -32768 to 32767.   Values 
that fall outside of this range will be incorrectly interpreted by the logger. 

 
You also have to enter a multiplier and format string to revert the converted values back to values for 
display. 
For example, “123.45” will be stored as 12345.   Therefore the multiplier must be 0.01 and format must 
be “##0.00”. 

o Floating point: Store the channels as 4 byte floating point values.   Note that this will work for all 
instrument types, but you will not be able to manipulate the channels in any way (e.g. calculation of 
averages). 

• Refresh Rate: Select how often to read the sensor.  
o Log Interval: Read the sensor once just before the log scan. 
o Fixed Interval: Read the sensor every “n” seconds. 
o Continuous: Read the sensor as fast as possible. 
o Manual: Manually initiate the SDI-12 via the Scheme Editor Events window. 

• Read Time: This field is only used when the Refresh Rate field (above) is set to Log Interval.   Enter the 
amount of time to allow for the sensor to complete its reading.   Note that since all sensors are read in turn, 
if you require all of the sensors read in time for the log scan then the easiest way is to add the time each 
sensor requires (rounded up to the nearest scan interval) + 1 scan for extra processing time e.g. Sensor 1 
takes 14 seconds, sensor 2 takes 23 seconds, scan rate is 5 seconds.   Sensor 1 would be set a read time 
of 15+5=20 seconds, and sensor 2 would be set a read time of 25+5=30 seconds.   The software would 
automatically query Sensor 1 50 seconds before the log, and Sensor 2 20 seconds later at 30 seconds 
before the log. 

• Refresh Interval: This field is only used when the Refresh Rate field (above) is set to Fixed Interval.   
Enter the number of seconds between initiating a read from the sensor. 

• SDI channel tab: Select the channel to edit. 
• Label: Enter a label for channel display in Test Mode and in the Data Viewer. 
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• Units: Enter the units for channel display in Test Mode and in the Data Viewer. 
• Multiplier: Enter the multiplier to scale the result by.   When using Integer Data Type refer to Data Type 

(see above) for correct calculation of multiplier. 
• Offset: Enter the offset to scale the result by. 
• Format: Specify the display format.   When using Integer Data Type refer to Data Type for the correct 

format. 
• Add: Click on Add to add a new channel to the instrument.   Note that you must define a channel for every 

parameter the sensor returns whether you need the channel or not. 
• Delete: Click to remove the currently selected channel from the instrument. 

SDI_DEBUG: SDI Debugger 
The SDI Debugger instrument can be used to monitor the SDI-12 queue system. 
 
The SDI Queue channel is the bit-mapped representation of the SDI-12 queue.   The MSB (far LHS) 
indicates that a read is in progress, and the other bits represent requests for data for each SDI-12 instrument 
in the scheme.   The SDI Data channel indicates that new data is available for that instrument. 

Requirements 
• 6004B, C or D Starlogger, Prologger or Micrologger data logger. 

Configuration 

 
• See Advanced Scheme Management on page 54 for details on the Generic Instrument Setup Window. 

SITEID: Site Identifier 
The site identifier instrument creates a special data channel that can be programmed with an arbitrary text 
string. 
 
The site ID is set after the logger has been programmed.   Open the Test Mode display, and then double-
click on the “Site ID” field.   Enter your site identifier and click OK. 
 
The Site ID can be logged like any other data channel on the logger.   It can also be used to name unload 
files.   See Data Options on page 12. 

Requirements 
• None. 

Configuration 
The only configuration option is adjusting the size of the site ID.   The size does not include a trailing zero 
that marks the end of the ID, therefore, if you need to be able to enter, for example, an eight character 
identifier, the site ID will take up nine bytes of logger memory. 
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SMS: SMS Dialout Group Manager 
The SMS Dialout Group Manager is used to send SMS messages in response to events. 
 
The instrument allows an event to be associated with a message and a group of telephone numbers.   When 
the event occurs, the message is sent to every number in the group. 
 
Different messages will require a separate dialout group for each message. 

Requirements 
• An SMS capable cellular modem.   Most GRPS and some CDMA modems are supported. 
• An Event is required to trigger each dial group.   See Events on page 29. 

Configuration 
Edit the SMS instrument by either double-clicking it, or right-clicking on it and selecting Edit from the menu.   
The following window will appear: 
 

 
 
• Name: This is the label for the dialog tab for each group.   It also appears in the Event Output selection list. 
• Description: This is also shown in the Event Output selection list. 
• Latch Alarm: Tick to latch the alarm.   Once latched, the alarm is always sent even if the alarm condition 

clears on the following scan. 
• Reset Delay: Only available when the Latch option is selected.   It is the number of seconds to wait before 

allowing a re-triggering of the alarm. 
• Dialout phone number list: This lists the telephone numbers the message will be sent to. 
o Adding: Click Add Number to add a number to the list.   When adding a number you may also add a 

short bit of text about the number, such as a name. 
o Editing: Select the number in the list, and then click on it again (double-clicking won’t work).   After a 

short delay the number will become editable. 
o Deleting: Click Delete Number to remove the selected number from the list. 

• Dial group SMS message text: This is the message that will be sent to the listed telephone numbers.   
There is no way to incorporate live readings or logged data into the message. 

 
Along the bottom of the window are buttons for managing the dial out groups: 
• Delete Group: This will delete the currently visible group.   It is not available when there is only one group 

defined. 
• Copy Group: Click this to create a duplicate of the current group.   It will be given the name “Copy of 

Name”, where Name is the name of the current group. 
• Add Group: Click this to create a new empty group.   It will be given the name “Dial Group #”, where # is a 

number equal to the number of groups now defined.   For example, if you have two groups defined and 
click this button, the new group will be named “Dial Group 3”. 
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Triggering a Dial Group 
To trigger a dial group so it sends its message to the listed numbers, it must be added as an Output of an 
Event.   See Events on page 29 for a detailed description of how to create and manage events. 
 
When you have set up your events, make sure the event Output is set to the required SMS Alarm Dial 
Group: 
 

 

T2L: Time Till Log 
The Time Till [Until] Log instrument provides a channel that contains the number of seconds until the next log 
interval.   This is typically used to synchronize events around the log interval, for example, to switch a device 
on 30 seconds before the log interval to give it time to take a reading. 

Requirements 
• A scheme with a fixed logging interval.   This instrument will not work correctly with event-based schemes. 

Configuration 

 
 
• See Advanced Scheme Management on page 54 for details on the Generic Instrument Setup Window. 

WINDOW: Window Controller 
The Window Controller instrument is a utility to let you switch an output on/off over several windows over the 
day e.g. for switching modem on for certain hours over the day.   The Window instrument also requires the 
RELTIME instrument and will add this instrument to the scheme for you automatically. 
 
Note that the output from the logger may need a relay or similar device to provide sufficient power to switch 
the required load. 

Requirements 
• Spare output channel. 
• Additional switching (relay) for large loads. 
• RELTIME Instrument (see RELTIME: Relative Time Channels on page 76). 
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Configuration 

 
 
• Window Tab: Select the Window to edit. 
• Switch On Time: Enter the time to switch on the selected output in 24hr time format. 
• Switch Off Time: Enter the time to switch off the selected output in 24hr time format. 
• Use Output: Select the output to switch On/Off. 
• Enable Window: Select this to use the window in the scheme.   Disabled windows are saved in the 

scheme so that you can easily re-enable them at a later date but are not included into the data logger 
program. 

• Add: Click Add to add a new window to the scheme. 
• Delete: Click on Delete to remove the selected window from the scheme. 
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Appendix – Communications Variables 
Communications variables are used in the scheme settings.   See Settings on page 23. 

General Variables 
Variable Default Description 

DEFAULT -1 When a communications profile is marked as 
DEFAULT = -1 then this is the default 
communications method used to connect to the 
logger. 

FORCEPROMPT [RTS] Action to take to try to solicit a prompt from the 
logger. 

• [RTS] = toggle RTS 
• [nnn] = wait for time nnn in ms 
• [CR/LF] = send carriage/return character 

MAXTESTMODECHANNELGAP 30 To speed up communications, requests to logger 
memory addresses that are close to each other are 
consolidated into a single request.   How close they 
need to be is measured by the number of bytes 
specified in this setting.   The default value is suitable 
for high-speed, low latency connections.   For low-
speed, high latency connections (e.g. satellite), this 
value could be increased. 

PROMPTRETRIES 2 Number of times to wait for a prompt. 

PROMPTTIMEOUT 20 Time in seconds to wait for prompt. 

RECEIVEBLOCKSIZE 256 for XRT 
loggers, 1024 
for other 
loggers. 

The amount of bytes requested at a time from the 
logger. During unload this value is halved for each 
timeout to a minimum of 256 bytes. 

SENDBLOCKSIZE 256 The amount of bytes sent at a time to the logger. 

TIMEOUT 5 Time in seconds to wait for any received 
communications. This timer is reset each time any 
new data arrives. 

TYPE RS232 The type of communications: 
• RS232 – Serial RS-232. 
• IP – Internet TCP/IP. 

Type RS232 Specific Variables 
Variable Default Description 

AUTOBAUD -1 When set to -1 (true) on receipt of an unexpected character 
BAUDRATE is automatically changed to try to synchronise to 
the correct baud rate. Expected characters are 0-9, A-F * and 
<CR>. 
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Variable Default Description 

BAUDRATE 9600 RS232 serial port baud rate. 

COMMPORT 1 RS232 communications port number (1 to 16). 

METHOD DIRECT • DIRECT = Connect direct to the RS232 serial port. 
• PHONEMODEM = Connect via a phone modem on an RS232 

serial port. 

OUTSIDELINE  Number to dial to reach an external line. Only prefixed to 
phone number if PHONENUMBER doesn’t start with 
OUTSIDELINE. 

PHONENUMBER  Number for phone modem to dial to connect to remote logger. 

RESET  String to send to modem to reset configuration. 

SETTINGS  Settings to configure modem. 

TELSWITCH  Telemetry switch number. 

TERMCHAR <CR/LF> Set the expected termination character from a phone modem. 

Type IP Specific Variables 
Variable Default Description 

ADDRESS  IP address of the remote site to connect to. 

METHOD UDP • UDP = Connect over network using UDP protocol. 
• TCP = Connect over network using TCP/IP protocol. 
• GPRSPROXY = Connect over network routing through 

the NIWA GPRS proxy server for remote cellular 
access. 

PASSWORD  Password to access the NIWA GPRS proxy server. 

PORT  Port of the remote site to connect to. 

PROXYADDRESS  IP address of the NIWA GPRS proxy server. 

PROXYCONNECTRETRIES 15 Number of times to check for a connection to the NIWA 
GPRS proxy server. The connection is checked once per 
second. 

PROXYPORT  Port to connect to on the NIWA GPRS proxy server. 

USERNAME  Username to access the NIWA GPRS proxy server. 

For XRT/NRT type loggers In the ENT buffer node 
Variable Default Description 

MEMORYOFFSET 4736 Magic offset to apply to the buffer control table registers 
to covert absolute address to logger virtual memory 
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Variable Default Description 

address. 
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Glossary 
 

Term Definition 

CDT Configuration Data Table.   A set of configuration values inside the logger. 

Channel An input that has been given an identifier and is able to be read and logged by the scheme 
program. 

Dump file Originally the same as an unload file.   Now more often refers to a file that contains an 
image of the loggers internal memory, used by Unidata engineers to provide technical 
support in some cases. 

Event A calculation that results in a true/false answer.   Based on that answer, other actions can 
be performed, such as switching a relay, or logging data. 

FTU Originally Field Test Unit – a handheld device used to test the operation of data loggers in 
the field.   Now used to refer to test displays on the PC that show the status of running 
schemes. 

Input An input into a logger.   Typical inputs are analogue (voltage), digital (counter pulses, on/off 
states, and data such as SDI-12). 

Load “Load a scheme” – the programming of a data logger with a scheme program. 

Log When the logger records data into its memory (buffer).   Typically, this occurs at a fixed 
interval controlled by the scheme program, but can also be triggered by events to occurs at 
arbitrary times. 

The time between the fixed logging intervals is called the log interval. 

Log start Data loggers without internal sensors (excluding the internal battery and temperature 
sensors) reserve one pin on their input connector to detect when an instrument has been 
connected before starting to log, and to stop logging when the instrument is disconnected. 

Logger An electronic device that keeps a record of data.   In the context of the Starlog system, this 
includes many instruments with a built-in logger (such as the 6526 Starflow and 6541 Water 
Level Instrument) as well as dedicated standalone loggers such as the Starlogger and 
ProLogger. 

NMM Neon Metering Module.   In general, the range of Neon loggers housed in plastic 
enclosures. 

NRT Neon Remote Terminal.   In general, the range of Neon loggers housed in metal 
enclosures. 

Output The actions taken as the result of an event.   As well as typical outputs such a signal sent to 
control a relay, outputs can also be entirely software in nature, such as forcing some data to 
be recorded. 

Prescale The dividing down of counter inputs to ensure a counter value will not exceed its maximum 
value before being read.   Prescaling allows for a greater range, but at the cost of reduced 
resolution. 

Prescan A brief period of time before the logger scan where the logger is able to switch on its power 
supplies to instruments and allow them to stabilize before the scan wakes up the logger to 
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take readings. 

Scan When the logger “wakes up” to read (scan) all of its inputs and perform the instructions 
specified by the scheme program.   A scan always occurs at a fixed interval specified by the 
scheme program at the time of programming.   Once programmed, the scan rate can only 
be changed by reprogramming the logger with a scheme.   Between scans, the logger is 
asleep and not performing any processing or monitoring any of its inputs, with the exception 
of the counter channels. 

The scan can be likened to the ticking of a clock; everything the logger does occurs on 
each tick. 

The time between scans is referred to as the scan interval. 

Scheme The instructions programmed into the logger telling it what to log, when to log, and any 
other actions or processing that it is required to perform. 

SDI-12 A standard that allows many instruments to be connected to a data logger via a common 
connection. 

Sleep The time the logger spends between scans.   When asleep the logger consumes almost no 
power and is only monitoring its counter channels. 

Sub-interval When logging a standard average, all the values read during each scan of the log interval 
are used in the calculation.   A sub-interval alters that by using a subset of the most recently 
scanned values.   For example, with a 1 hour log interval, a 1 minute scan interval and a 15 
minute sub-interval, only those values read in the 15 minutes before the log are used in the 
calculation of the average.   The values read during the other 45 minutes are ignored. 

Unload “Unload a logger” – the transfer of logged data from the logger to outside storage, typically 
a PC, but potentially a handheld device, or an intermediate data server. 

Unload file A data file containing data unloaded from a data logger. 
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